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Introduction

1

Content Matrix Console - File Share Edition is a powerful workbench application designed to perform

end-to-end migrations of legacy content to enterprise SharePoint systems. In particular, Content

Matrix Console - File Share Edition is designed to efficiently migrate file share content to SharePoint

Products and Technologies. With its familiar copy-and-paste style user interface, you can quickly

migrate your File Share document content into SharePoint.

Whether deploying a small corporate file share with several hundred documents, or an enterprise wide

file share of hundreds of thousands of documents, Quest solutions accelerate the migration process

and reduce the time and effort required to deploy.

  

Supported Source Systems
The following source systems are supported in Content Matrix Console:

· Windows File Shares (Local or Networked drives)

· Mapped network drives

· SharePoint Server 2007 and later - Document off-loading only  
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Supported Target Systems
The following target systems are supported in Content Matrix Console:

· SharePoint 2016

· SharePoint 2019

· SharePoint Server Subscription Edition

· Microsoft 365 (including One Drive, Teams, and Groups)

Key Features
There are many advantages to using Content Matrix Console, including the following:

Ease of use
Similar to the Windows File Explorer, Content Matrix Console has a familiar, tree-based copy-and-

paste style user interface. 

Valuable data retention
All version chains, metadata, user-edit information, and most views can be preserved.

Multiple site connections
Connect to multiple SharePoint sites, across any number of servers, for easy consolidation or

distribution of your SharePoint data.

Working remotely
Do all the heavy lifting for your SharePoint migration from the convenience of your own machine.

Content Matrix Console connects to any SharePoint site that you can access with your browser, even

those outside your organization's intranet.

Batch work
Multiple list migration operations can be batched up for convenience, and re-run at any time. Run your

migrations at night and view the results/logs in the morning.

Compliance
All migration activity is done through the supported SharePoint APIs. There are no unsupported, direct

writes to the SharePoint database.

PowerShell functionality
PowerShell functionality is incorporated into the Content Matrix User Interface (UI), and any action in

the UI can also be performed with PowerShell. Cmdlets are also included, so scripts can be manually

created and run. 
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Product Announcements Splash Screen

When you launch the Content Matrix Console, a splash screen displays with the latest Content Matrix

product announcements.  If you have internet access, you will receive announcements directly from

the Quest website.  If you do not have internet access, the splash screen displays offline text included

with your Content Matrix installation.

You have the option of preventing this screen from displaying in the future by clicking the Do not show

this screen again box.  (If you select this option, display of the splash screen will resume the next time

you perform a Content Matrix Console installation or upgrade.)

Automatic Updates

Content Matrix Console can automatically check online to see if a more recent version of the product

is available for download. This takes place when Content Matrix starts.  To help ensure that you are

taking advantage of the latest features and fixes, it provides a direct line to download and installation

of new Content Matrix builds.

Automatic Upgrades requires access to the internet. While Content Matrix will check every time it is

opened, it is also possible to run a manual check. To do so, go to the main toolbar and choose Help >

Check for Updates.

If you are already running the latest build, the Check for Updates dialog will open and you will be

informed that you already have the latest version installed. If there is a new build available for

download, the Download and Install Update dialog will open.

Running the Automatic Update
When Content Matrix checks for updates and finds a newer build available for download, users will be

prompted to update with the Download and Install Update dialog.

1. Click [Download] to directly download the latest build to your current machine. 

The progress of the download is displayed in the Download progress bar.

NOTE:  If you are accessing the internet through a proxy server, the here link can be clicked on to

open the proxy configuration dialog.

2. Once the download is complete, click [OK] to continue.
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The Download and Install Update dialog will still be open, but the Download button will be replaced

with the [Install] button.

You will have the option of installing the new build directly from here by clicking the [Install] button.

This will open the Installation guide. If you are continuing the installation process directly from this

dialog, then the Content Matrix Console will close itself down, so the install process can be run.

NOTE:  When running the automatic upgrade process, only the latest build of the Content Matrix

Console will be updated. Any installations of the Metalogix Extensions Web Service will have to be

updated manually.  See the Content Matrix Advanced Install Guide for details.
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2

You will be prompted to input an Activation License Key when launching the Content Matrix Console:

· for the first time after it has been installed if an existing license is not detected

OR

· after your license has expired.

NOTE:  If users are not required to be a local administrators on the machine where Content Matrix is

installed, every user who launches a Console needs to enter a license key.  If users are required to be

a local administrator, only the first user who launches a Console needs to enter a license key.

IMPORTANT:  During installation, all Editions of the Console (SharePoint, File Share, and Public Folder)

are installed.  However, the license will only be activated for Editions that are covered by it.  If an

Edition is not covered by the license, the message Invalid license: License key is not valid for the given

product. will display in the Activate License Key dialog. A license key that starts with 823, 824 or 827

will not work with File Share Edition since its reintroduction in version 9.9. 

If you are performing an online activation, you can also do it silently, using Powershell.

To enter a license key:

1. In the Activate License Key dialog, select I have a license key, and enter the license key provided

by Quest (the key can be copied and pasted into the provided space).
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NOTE:  If you are updating from a Content Matrix installation older than version 6, select the I am

updating from an older version and have an old-style key option, and enter the key in the

provided space (or paste into the first field from your clipboard).

2. Select the appropriate activation method. 

NOTE:  Most systems can use the Online activation method as long as the system has internet

access. If you are unable to use the online activation method due to security settings or lack of

internet access, the Offline activation option can be used.

Online Activation
NOTE:  In order to activate your license, the following URL must be unblocked by your firewall: 

https://license.metalogix.com

1. After entering the license key, select Online activation. 

2. If you need to configure proxy settings:

§ Click the Set proxy… link.

§ Follow the procedure for Configuring Proxy Settings.

3. Click [Next].

Content Matrix will contact the licensing server and attempt to authenticate the license key, after

which, on successful activation, a 'Congratulations!' message will be returned, and the license key

will be active and in use.

4. Click [Finish] to complete the process.

http://license.metalogix.com
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Offline Activation
NOTE:  The offline activation option is generally used in cases where you cannot use the online

activation due to security settings or lack of internet access. This option will still require some

internet access, but allows for the authentication to be done from another machine that is not as

restricted by security or has a connection to the internet.

1. Select Offline activation.

2. Click [Next].

A Generate Activation Request dialog displays with a different key. This key can be copied from

the window, or the Save to file option can be used to save the key into a text file (in case it needs

to be copied to another machine).

3. Copy the Activation URL (listed under the Activation Request) to a web browser that has internet

access. 

Alternately if the system the Content Matrix Console is on does have internet access through a

Web browser, click Go to automatically open a web browser to this URL.

4. On a machine that has internet access, use the Activation URL to navigate to the Offline Activation

page.

5. Either:

§ Enter the key into the Activation data text box. 

OR 

§ If the key was saved to a file, select Browse and navigate to the file.

6. Click [Activate].

Upon successful activation, a new key displays in the text box.

7. Do one of the following:

§ To save the key as a DAT file, click [Download file].

OR

§ To copy the key to the clipboard (if the license will be activated on the same machine), click

[Copy text].

8. Click [OK] to continue.

9. Return to the Activate License dialog.

10. If the Generate Activation Request window is still active, click [Next]. to the Enter your Activation

Response window.

11. Use one of the following options:

§ If you copied the key to the clipboard on the same machine, paste it into the window.

§ If you saved the key to a DAT file, navigate to, and select the DAT file. 

12. Click [Next]. The license key will be active and in use.
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13. Click [Finish] to complete the process.

Checking the Current Content Matrix Console
License

To check the status of the license key in use, open the About dialog. Here, information such as the

license type, expiration date (if any), size limitations for migrations, and how much data has already

been migrated can be seen.

NOTE:  If an offline license is used, the offline activation process will need to be used to do this

update instead, unless the system that the Content Matrix Console is installed on has internet access.

To check the current license:

1. In the Content Matrix Console ribbon toolbar, choose Help > About.

2. In the dialog that opens, click [Refresh]. This will initiate a refresh of this data from the licensing

servers and update the information.
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3

The Content Matrix Console User Interface (UI) is simple and easy to use. There are three high level

components to the configurable interface:

· Explorer View 1 - At minimum, the interface will always display one Explorer Control, providing

multiple ways to view the content for any active connections to source and target environments.

· Explorer View 2 - A second explorer control can be displayed simultaneously. Having two explorers

visible allows the user to simultaneously view two different parts of the connected content set. For

example, in many cases it makes sense to show a migration source on the left in Explorer Control

1, and a SharePoint migration target on the right in Explorer Control 2.

· Job List - Beneath the Explorer Control windows is a Job list that shows the history of migration

jobs and other tasks that have been run or batched in Content Matrix.

More information on these UI components is provided in the topics that follow.
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Main (Ribbon) Toolbar

At the top of the Content Matrix Console is a ribbon toolbar allowing access to the following five menu

group settings:

· Connection

· View

· Settings 

· Help

The Content Matrix Console menu ribbon can be expanded or minimized to fit the user's needs. When

expanded, a set of options will be available depending on the selected menu heading. 

When minimized, options will only be visible when a menu heading is selected. Otherwise, only menu

headings will show. The minimize and expand options can also be accessed by right-clicking an option

in the ribbon itself. This opens a context (right-click) menu where the Minimize the Ribbon option can

be selected or deselected.

Quick Access Toolbar

The Quick Access Toolbar can be accessed above the ribbon. The Quick Access Toolbar can also be

moved just below the ribbon by selecting the drop down menu (on the top left-hand side) and choosing

Show Quick Access Toolbar Below the Ribbon, or it can be placed back above the ribbon by choosing

Show Quick Access Toolbar Above the Ribbon.  Any option that is available under one of the menu

group headings can have a shortcut for the option placed into the Quick Access Toolbar. This can be

done by right-clicking on the option in the ribbon, and choosing Add to Quick Access Toolbar.  
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Shortcuts can also be removed from the Quick Access Toolbar either by selecting the option within the

ribbon and opening the context (right-click) menu, or by selecting the shortcut option itself, opening the

context (right-click) menu, and choosing Remove from Quick Access Toolbar.

Explorer Control View Tabs

The Content Matrix Console user interface uses an Explorer Control style window which allows you to

navigate, view, and select the desired content for migration. The Explorer Control window is broken up

into three separate tab options, each of which contains its own set of options for viewing content and

data. They are:

· Explorer View Tab

· Items View Tab 

· Browser View Tab 

Explorer View Tab

The Explorer view tab allows you to navigate through your various connections in a tree view.  You can

navigate to and selected a desired SharePoint site collect, site, list/document library or sub-folder or a

under a specific connection or a specific file share source connection.

There are a set of filtering options that are available in this tab, as well as a set of ordering options.
This allows you to display, sort, and filter all of your connections as desired.
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There are three primary Filtering options: Text Filter, Connections Filter, and Status Filter.

· Text Filter:  For example, if you only want to view connections that contain "2010" in the URL, you

can enter "2010" in the Filter text box, and click the Filter button to the right of the text value. The

filter will then be applied to all connections in that Explorer View tab, and only connections that

contain a "2010" value will be displayed.

NOTE:  To remove a text box filter, delete the filter value from the text box and re-run the filter

action.

· Connections Filter - This option consists of a drop down menu that allows you to filter by

connection type. By default, all of these options are selected, but one or more can be DE-selected.

 

· Status Filter - This option  consists of a drop-down list with the various connection status options.

§ NotChecked – Content Matrix has not tried to validate the connection yet.

§ Checking - Content Matrix is currently trying to validate the connection.
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§ Valid - Content Matrix has tried to validate the connection, and has been successful. A

connection has been established.

§ Invalid - Content Matrix has tried to validate the connection, and has been unsuccessful. A

connection has not been established.

§ Warning - Content Matrix has tried to validate the connection, and has been successful. A

connection has been established, however, a warning message has been given.

By default all of the status types are selected but, as with the Connections Filter, one or more can be

de-selected.

You can also Sort by 

· Default - All of the connections in the order they were added.

· Type -These are the same types that are listed in the Connections Filter drop down menu. When

selected, connection types will be sorted in the following order:

§  FileShare Connections

§ SharePoint farms (this includes all Web App and Farm connection to a server, as well as

Database connections)

§ SharePoint Site connections, which include Site connection types, and Read-only connections to

SharePoint  

You can combine various filter and sort options.

Items View Tab

The Items View tab displays any items/documents that exist directly under the selected node (that is,

the content of any subfolders under the selected node-will not be displayed), along with column

metadata.
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There are four main options that are available through this tab. These options are:

· Search – To perform a full or partial text search, enter the string in the search box then either and

either press <Enter>, or click the magnifying glass icon to run the search. 

NOTE:  The search will be run on the name column (the FileLeafRef) by default, but you can select a

different  column to search from the drop-down to the right of the search box.

· Refresh - This button will refresh all of the items in the Items View tab.

· Show/Hide Version History - This button option is only available when the selected document

library/list has versioning configured. When this button is selected the Items View tab will be

divided into two sections, a top section displaying all of the items/documents and a bottom section

displaying all of the versions for the selected item/document.
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When an item/document is selected in the top window, all of that item/document's version’s will

be listed in the bottom half of the window. You can then look at the metadata for each

item/document version that exists. This option can be combined with the Show/Hide Properties

button.

If the Show Version History button has already been selected, this will change to be a Hide Version

History button instead. You can use this option to stop looking at item/document version histories.

· Show/Hide Properties - The Show Properties button allows you to see a list-style view of the

available fields (columns) and their values, for a selected item/document. Any value listed in dark

text can be edited and within the window. 

The fields in the Properties window can also be ordered by category, or alphabetically. By default, the

fields are ordered by category, and are listed alphabetically within each category. If listed

alphabetically, then all property fields (columns) will be listed in alphabetical order, with no breakdown

by category. There are two buttons at the top of the Properties window that can be used to determine

what ordering type is used. This option can be combined with the Show/Hide Version History button.

If the Show Properties button has already been selected, this will change to be a Hide Properties

button instead. Use this option to close the Properties window.

Browser View Tab

The Browser View displays a view of the content as it would be seen in a web browser for a selected

SharePointnode. It is also available if selecting a single item in the Items View. When selected, this tab

will display a fully functioning web browser view of the selected content. You can use this Browser

View to navigate or work with their content, the same way they would through a normal web browser

window.
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Jobs List

Jobs in Content Matrix Console can be managed from the Job List. Jobs are listed for migration actions

that have already been run, as well as for actions that have been saved.  

Using the Connection Search Function

This search feature allows you to do a search through a File Share connection orthe top-level node of a

SharePoint connection for  sites, lists, folders, and files.  Filters can also be applied to the search

criteria using the four main metadata fields (Created, Created By, Modified, Modified By) as well as

content types. The search results can be sorted through, and you can view each returned item's

properties.  You can also run actions on returned items using the right-click menu. 

NOTE:  In addition to the Search feature, the Find feature can be used on File Share sources from the

Items View tab.

To run a Search:

1. In Explorer View, select the connection in which you want to search.

2. Right-click and choose Search.

3. Enter a Search Term/Filter and/or click [Advanced Options] and select any additional criteria you

want to use.
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4. Click [Search].

All the results of the search display in the bottom pane.  Select a result from the list to:

· View the metadata field properties for a selected item (by clicking [Show Properties]).

· Perform an action on a selected item (by right-clicking it and choosing the action).

Using Multi-Select

Multi-select can be used to select a number of nodes on the source side Explorer View tree, and

migrate those nodes to a target SharePoint instance. Multiple SharePoint connections can be selected

at one time, but only to Disconnect or Refresh those connections. If connected to a SharePoint farm

or web application, only a single site collection can be selected at a time, however, multi-select can be

used on any sub-sites under a single site collection.
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This feature also works for migrating a single list or site into multiple target locations at the same time;

for example, if you have a document library that you want to migrate into two or more target

SharePoint sites. After the library is copied, any number of desired target sites can be selected, as long

as they are all under the same target connection node, and when pasted the list will be migrated to all

of the selected target site nodes. The basic cases for multi-select are copying: multiple to one, one to

multiple, and multiple to multiple.

For example, if connected to a File Share in the Explorer View, and the navigation tree is expanded, you

can select a number of folders (Folder A, Folder B, etc.) and these can all be migrated at the same time.

After pasting the content all the selected content (Folder A, Folder B, etc.) will be migrated under the

target SharePoint node.

In addition to using check boxes to multi-select, you can use <Shift> and the <Ctrl> keys in the

conventional way.

Limitations of Multi-Select

There are a few limitations when using multi-select. These limitations are:

· Only one node type can be selected at a time - This means that if a SharePoint site node is

selected, then only other site nodes can be selected, and included in the action. If a File Share

connection type is made, only nodes under each specific connection can be selected at one time 

While the content under those nodes will be migrated (as per the selected options), only other site

nodes themselves can be selected. This is the same for SharePoint lists/libraries, and folders. When

connected to a SharePoint server only a single site collection can be selected at one time, but

multiple sites under the site collection level can be selected. 

The first node selected in the multi-select will determine what type of node can be included, and if

an invalid selection is made, then the node that you tried to select will only blink. For example, if a

list is selected, then only other lists, within the site collection, can be selected. If you try to select a

SharePoint folder or site, then this is an invalid selection, and the folder or site will blink.

· Available Context (Right-Click) Menu Options - When using multi-select the options that are

available in the context (right-click) menu can change depending on where the multi selection is

taking place.
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Enabling Advanced Mode

4

Some options in Content Matrix are considered "advanced" and are disabled by default. Options that

require Advanced Mode are identified throughout this documentation.

 To enable Advanced Mode:

In Content Matrix Console ribbon toolbar, choose Settings > Enable Advanced Mode. 

NOTE:  When the button is highlighted, Advanced Mode is enabled, and additional options become

available for nodes/items selected in Explorer and Item View tabs. Transformation Options  become

available as well. 
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Enabling and Disabling Optimistic
Mode

5

Content Matrix Console - File Share Edition has an Optimistic Mode designed for faster migration of

content from a File Share to SharePoint by eliminating some of the additional checks that are normally

made as part of the migration process.  Optimistic Mode is an option that can only be set on a root File

Share connection node (and not on a root SharePoint connection node). 

NOTE:  As of version 8.5.0.4, Optimistic Mode is disabled by default.

Known Limitation:  Large File Migration

Currently, Optimistic Mode does not support large file migration.  For a CSOM target connection, if a

file over 250 MB is encountered during migration, a message will be logged that prompts you to disable

Optimistic Mode before attempting to migrate it.

How Versioning is Handled Based on Mode and SharePoint
"Require Check Out" Setting

Optimistic Mode works best when the SharePoint setting Require Check Out is disabled.  If both

Optimistic Mode and Require Checkout are enabled, migrated files will need to be manually checked in

after migration.  The following table identifies how versioning is handled based on the various

combinations of the migration mode and the Require Check Out setting.

If Optimistic

Mode is ....

And the

SharePoint Require

Check Out setting

is ...

Then ...

enabled enabled

the files will be checked out on the target and they will

be given a version number by SharePoint after they are

manually checked in.

TIP:  If you notice that all of the migrated documents

are in the checked-out status, it is likely that the

SharePoint Require Check Out setting is enabled. This

can be verified in the document library versioning

settings (Document Library Settings > Versioning

Settings). If this option is enabled there are two

solutions available to migrate the File Share content
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If Optimistic

Mode is ....

And the

SharePoint Require

Check Out setting

is ...

Then ...

and have the documents checked-in after migration.

The first option is to disable Optimistic Mode. The

second is to disable the Require Check Out SharePoint

setting by switching it to No, then switching it back to

Yes after migration. 

disabled

the files will be incremented by the smallest version

number type that is available (that is, by one minor

version or major version depending on what version

types are set).

disabled

enabled

all of the files will be migrated and automatically

checked in, and they will have the same version number

that existed in the source environment.

disabled

the documents will have a version number of 1.0

(because the documents will be viewed as "new" in the

SharePoint environment, and they will be published as

the first major version).

To enable or disable Optimistic Mode:

In Content Matrix Console main ribbon, choose Settings > Enable Optimistic Mode, which is:

· Highlighted when enabled 

· Not highlighted when disabled
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Connecting to a File System

6

In order to connect to a File Share, you will need the system path (address) to the file share, and your

login account must have access to the File Share.

To Connect to a File System Directory:

1. In the main Console ribbon, select Connection > Connect to File System.

2. In the Connect to File System dialog, either:

§  enter the connection path to the File System

OR

§ click [Browse] and navigate to the file share.

NOTE:  If you are copying a Sensitive Content Manager (SCM) report that has been imported into

Content Matrix, make sure that the connection uses the same Source Path that is specified in the .csv

file.

3. Click [OK] to establish a File System connection.  

Note that, by default, the Explorer view shows only the folder structure of the connected File System. 
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To show files in Explorer View:

1. Select the top level connection node for the File Share connection.

2. Right-click and choose Show Files.

NOTE:  To re-hide files, select the top level node, right-click and choose Hide Files.
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Connecting to SharePoint

7

The following basic connection adapters are supported for making connections to SharePoint from

Content Matrix Console:

· A local connection to a SharePoint site or server *

· A remote connection to a SharePoint site or server

·  A client side object model (CSOM) connection for SharePoint Online at the site level

· An Microsoft 365 Tenant connection (based on the CSOM connection type) 

 * As of version 9.3 the Content Matrix Console client application requires Microsoft .NET Framework

4.7.2 to run. Since this .NET requirement applies to the machine on which Content Matrix is installed,

Content Matrix cannot make a local Object Model (OM) connection on a SharePoint 2007 or 2010

environment, because SharePoint 2007 and 2010 require an earlier version of the .NET Framework

(v.3.5), which prohibits Content Matrix from completing the connection.  Because of this, any

migration ‘jobs’ configured to connect to SharePoint 2007 and 2010 environments using a Local OM

connection type will cease to work, and these jobs will need to be recreated for use over MEWS.

The following table identifies the connection adapter types for each supported version of SharePoint:

SharePoint

Server Type

Local Object Model

(OM) Connection

(Content Matrix

Console - installed on

server)

Remote Object Model

(OM) Connection

(Metalogix Extensions

Web Service installed

on remote server)

SharePoint Client Side

Object Model (CSOM) 

(includes support for

Microsoft Teams, One

Drives and Groups)

Microsoft 365 Tenant

Connection

(includes support for,

One Drives)

Microsoft 365 -

Microsoft

SharePoint 2016 - -

Microsoft

SharePoint 2019

* *

- -

Microsoft

SharePoint

Subscription

Edition
*
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* Currently, if Content Matrix is installed in a FIPS-enabled environment, you cannot connect to or

migrate to SharePoint 2019 with a local or remote server connection. For SharePoint Server

Subscription Edition in a FIPS-enabled environment, you can only connect using a remote object model

connection.  See Errors Connecting to SharePoint 2019 or SharePoint Server Subscription Edition in a

FIPS-Enabled Environment for more information.

 

Connecting to a SharePoint Site or Server
The same connection methods and options can be used for a normal connection to SharePoint and a

read-only connection to SharePoint. The below steps can be used for both connection types. The read-

only connection can be used to help users keep their source and target connection separate (and it can

help ensure that users do not accidentally migrate any data to a source connection).

NOTES: 

· When making a secure connection to a SharePoint URL that is configured with TLS, Content Matrix

can use any version of TLS that is compatible with .NET Framework 4.7.2.  The default version of

TLS used by the operating system on the machine from which you are connecting will be used by

Content Matrix.  

· Currently, connections to a SharePoint server cannot be made for SharePoint 2019 in a FIPS-

enabled environment. (See Errors Connecting to SharePoint 2019 or SharePoint Server Subscription

Edition in a FIPs-Enabled Environment for more information.)  

To connect to a SharePoint site or server:

In the Content Matrix ribbon, choose Connection > Connect to SharePoint.
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To complete the Connection Options tab:

1. For Address, enter either the URL or IP address of the SharePoint site or server to which you want

to connect.

Note that the drop-down menu displays a list of previous connections.

2. For Target Type, select the connection type.  Use the information in the following table for

guidance.

If you want to connect… Select …

directly to a SharePoint site Site.

to a specific Web application on a

SharePoint server

Web App.

NOTE:  This option can only be used if using the

Local or Metalogix Extensions Web Service

connection type.

to a SharePoint instance at the

Farm/server level 

Farm.
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If you want to connect… Select …

(which will allow you to see all site

collections for all Web Application on the

selected server)

NOTE:  This option can only be used if using the

Local or Metalogix Extensions Web Service

connection type.

3. Select a Connection Type from the drop-down.  Use the information in the following table for

guidance.

 

If … Select … Notes

you want to have

Content Matrix choose

the connection

adapter type that

makes the most sense

for the target

SharePoint instance

Auto Detect
· If the SharePoint instance is local

(installed on the same machine as the

Content Matrix Console), the Local

Connection (SharePoint Object

Model) will be used

· If the SharePoint instance is remote

(installed on another machine), and the

Metalogix Extensions Web Service is

installed, the Remote Connection

(Metalogix Extensions Web Service)

type will be used.

Content Matrix

Console is installed

locally (that is, on the

same SharePoint

server or one of its

Web Front Ends (WFEs)

Local Connection

(SharePoint Object

Model)

This connection type 

· is generally recommended for the

target SharePoint instance if possible,

to help with performance and to help

provide the product with greater

leverage into SharePoint.

AND

· the account used for the connection.

must be the logged in user and have

the following permissions:

· Farm Administrator

· Site Collection Administrator

· DB_Owner on the Content

Database (to allow the connecting
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If … Select … Notes

user access to the local SharePoint

Object Model).   

· Content Matrix

Console is not

installed locally

AND

· Metalogix

Extensions Web

Service (MEWS) is

installed on the

SharePoint

server/WFE to

which you are

connecting 

Remote Connection

(Metalogix Extensions

Web Service)

The connecting account requires Full

Control over the content being connected

to and migrated. Additional permissions are

provided through the use of the Metalogix

Extensions Web Service.

NOTE:  Although it is strongly

recommended that the version of the

Metalogix Extensions Web Service

(MEWS) match the installed version of

Content Matrix, you can override it to use

an earlier MEWS version.

NOTE:  As of version 9.5, Content Matrix no longer supports CSOM connections to SharePoint on

premises.  The option will work for backward compatibility with existing jobs, but if you select it

for a new connection, a pop-up warning will display.

4. For Authentication Type, select the method to use when trying to connect to the specified

SharePoint instance. 

Use the information in the following table for guidance.

If … Select …. Notes

you want Content Matrix to

automatically check against

the SharePoint environment 

Auto Detect Content Matrix will check for non-

Microsoft 365 authentication types

listed in the drop-down (in order), and

use the first method that is found.
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If … Select …. Notes

you want to connect to the

SharePoint environment

using the currently logged in

Windows user’s credentials

Windows

Authentication

· The logged in user credentials are

used by default; however, other

credentials that use this 

authentication method can also be

entered. 

· This is the authentication type that

most environments use.

· you selected Metalogix

Extensions Web Service

as the Connection Type

AND

· you want to connect

using Forms Based

Authentication

Forms Based

Authentication

· Most setups for Forms Based

Authentication are supported. 

· This method is limited to the

Metalogix Extensions Web Service

connection type because it

authenticates through IIS and not

Active Directory (AD).

NOTE: This authentication type is not

supported for running a job using a

PowerShell script. Refer to the Quest

Support Knowledge Base article

Connections that will work with

PowerShell and Connections that

doesn't work with PowerShell for

complete details.

you want to connect through

a Web browser 

Web Browser

Authentication (Not

Auto Detected)

This option is not searched for within

the “Auto Detect” option, and needs to

be manually set. 

In order for the Content Matrix

Console to logon to the system, users

must have logged on to the system

being connected to through the web

browser on that system first (only

before the initial connection). Since

this is all done using the Web browser

for authentication, the credentials

section of the window will be grayed

out (since it is not needed), and it is

limited to the Metalogix Extensions

Web Services Connection Type

because it authenticates through IIS

and not the Active Directory (AD).

NOTES:  

https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
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If … Select …. Notes

· Because this authentication type

uses cookies from the browser, it

may require multiple logins when

running a single migration.

However, this is only likely if the

migration is running for a long

session; this is mainly determined

by the web browser settings for

authentication. In the event that a

login is required, a dialog box

appears that lets users log in. After

the user logs in, the migration will

continue from where it left off.  

 

· This authentication type is not

supported for running a job using a

PowerShell script. Refer to the

Quest Support Knowledge Base

article Connections that will work

with PowerShell and Connections

that doesn't work with PowerShell

for complete details.

5. For Connect As, enter/select the login credentials you want to use to connect to the SharePoint

site/server. Use the information in the following table for guidance.

NOTE:  This option is disabled if you selected Local Connection (SharePoint Object Model) or

Web Browser Authentication (Not Auto Detected). 

If you want to … Then …

use the current Windows

user's authentication

credential

Select the (default)  <Domain>\<user> radio button.

use different authentication

credentials
· Select the Different User radio button, and

· Enter the applicable user name and Password. 

In cases where alternate credentials are entered, it is

recommended that you select the Remember my password

check box so Content Matrix will automatically remember that

user account password.  This is especially important if you chose

Web Browser Authentication, as credentials must be stored in

the Credential Manager vault before the connection is made. 

https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
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6. If you need to configure proxy settings:

a) Select the Proxy Options tab.

b) Follow the procedure for Configuring Proxy Settings.

7. If you want to Add or Remove certificates to be included when connecting to SharePoint:

a) Select the Included Certificates tab.

Please see the Connecting with Certificates for more details on connecting to SharePoint

instances that require certificates.

b) After all of the desired connection options have been set, for all options tabs, click [OK] to

establish the connection.

If you selected a connection type other than Site, the Limit Site Collections dialog displays, giving

you the option to limit the site collections to include in your connection (when importing an xml file

with the list of URLs you want to include).  This is useful if the environment you are connecting to

includes a very large number of site collections. In this case, limiting displayed site collections can

improve performance.

NOTE:  If you want to View Sample xml, click the link on the dialog.  The xml file you import must

follow the same format as this sample.

8. Either:
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§ Click [Yes – Import from XML] to specify the URLs of the sites you want to include in the

connection, then browse/upload the file

OR

§ Click [No – Continue with Connection] to add all sites within the selected scope to the

connection.

If Content Matrix successfully makes the connection, a new node will appear in the Explorer View, and

you can expand this node and navigate through the SharePoint objects. 

Connecting to SharePoint Online

Content Matrix Console can make a tenant or site level connection to a SharePoint Online

environment.   

To connect to SharePoint Online:

In the Content Matrix ribbon, choose Connection > Connect to SharePoint.

 

To complete the Connection Options tab:

1. For Address, enter either the URL or IP address of the SharePoint site or tenant to which you want

to connect.
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Note that the drop-down menu displays a list of previous connections.

2. For Target Type, select the connection type.  Use the information in the following table for

guidance.

If you want to connect… Select … Notes

directly to a SharePoint

site

Site. This option must be used for a

site-level connection to a

Microsoft 365 tenant

NOTE:  If you want to connect

to a Microsoft 365 tenant root

node, use the Microsoft 365

Tenant connection type.

to the root of a

Microsoft 365 Tenant

environment 

(comparable to a farm-

level connection in an on

premises environment) 

Microsoft 365 Tenant. This connection type has most of

the limitations of the CSOM

connection adapter, but can run

Site Collection migrations.

 

3. For Connection Type, select Remote Connection (SharePoint Client Side Object Model O365).

NOTE:  If you accept the default (Auto Detect), this option will be detected automatically.

 

4. For Authentication Type, select the method to use when trying to connect to the specified

SharePoint instance. When connecting to Microsoft 365, the two main Authentication Types will be

Microsoft 365 OAuth/Standard/ADFS Authentication and Microsoft 365 Web Browser

Authentication (Not Auto Detected).  Use the information in the following table for guidance.

For a  SharePoint Online connection that uses"modern" (not "legacy") authentication, you must select

one of the Microsoft 365 OAuth Authentication options or Microsoft 365 Web Browser.  If the account
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is also part of a SharePoint Online Multi-Factor Authentication Policy, Microsoft 365 Web Browser or

Microsoft 365 OAuth with MFA Authentication must be used.

NOTE: Microsoft 365 Web Browser Authentication is not supported for jobs run from a PowerShell

script.

For more information about legacy vs. modern authentication, refer to the Microsoft article Microsoft

365 feature descriptions.

If … Select …. Notes

you want Content Matrix to

automatically check against

the SharePoint environment 

Auto Detect Content Matrix will check for

authentication types listed in the drop-

down (in order), and use the first

method that is found.

NOTE:  At the time you click [OK] to

complete the connection, a pop-up

box will display that asks if you want

to use Microsoft 365 OAuth.  See

Using Microsoft 365 OAuth

Authentication to Connect to

SharePoint Online for details.

· you want to connect to

Microsoft 365 OAuth,

Microsoft 365 – Standard

editions, or systems with

ADFS

AND

· MFA is not being used 

Microsoft 365

OAuth/Standard/ADFS

Authentication*

By default the logged in user

credentials will be unavailable, since

this uses the Windows authentication

method, and the Microsoft 365

credentials will need to be entered.

NOTE:  At the time you click [OK] to

complete the connection, a pop-up

box will display that asks if you want

to use Microsoft 365 OAuth.  See

Using Microsoft 365 OAuth

Authentication to Connect to

SharePoint Online for details.

your account requires the

use of Multi-Factor

Authentication (MFA)

Microsoft 365 OAuth

with MFA

Authentication (Not

Auto Detected)*

With this authentication type,  you do

not have to enter account credentials

in Content Matrix, and the Connect As

options will be disabled. 

you want to connect through

a Web browser 

Web Browser

Authentication (Not

Auto Detected)

This option is not searched for within

the “Auto Detect” option, and needs to

be manually set. 

In order for the Content Matrix

Console to logon to the system, users

must have logged on to the system

https://social.technet.microsoft.com/wiki/contents/articles/36857.sharepoint-online-o365-set-up-multi-factor-authentication.aspx
https://learn.microsoft.com/en-us/microsoft-365/admin/m365-feature-descriptions?view=o365-worldwide&tabs=User-account-management
https://learn.microsoft.com/en-us/microsoft-365/admin/m365-feature-descriptions?view=o365-worldwide&tabs=User-account-management
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If … Select …. Notes

being connected to through the web

browser on that system first (only

before the initial connection). Since

this is all done using the Web browser

for authentication, the credentials

section of the window will be grayed

out (since it is not needed), and it is

limited to the Metalogix Extensions

Web Service Connection Type because

it authenticates through IIS and not the

Active Directory (AD).

NOTES:  

· Because this connection method

uses cookies from the browser, it

may require multiple logins when

running a single migration.

However, this is only likely if the

migration is running for a long

session; this is mainly determined

by the web browser settings for

authentication. In the event that a

login is required, a dialog box

appears that lets users log in. After

the user logs in, the migration will

continue from where it left off.  

· This authentication type is not

supported for running a job using a

PowerShell script. Refer to the

Quest Support Knowledge Base

article Connections that will work

with PowerShell and Connections

that doesn't work with PowerShell

for complete details.

you want to connect through

a Web browser using

authentication for Microsoft

365

Microsoft 365 Web

Browser Authentication

This option works the same as Web

Browser Authentication (Not Auto

Detected) except:

· it looks for more specific Microsoft

365 cookies

· it requires that users first log into

Microsoft 365 through the browser

https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
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If … Select …. Notes

· instead of allowing multiple logins,

only one "request" for data can be

made at a time, which ensures that

no data is missed or lost due to the

system locking from too many

requests (but which may result in a

slower connection).

NOTE: This authentication type is not

supported for running a job using a

PowerShell script . Refer to the Quest

Support Knowledge Base article

Connections that will work with

PowerShell and Connections that

doesn't work with PowerShell for

complete details.

you want to make a site-

level connection to a GCC

High site using Microsoft 365

User Provided

Authentication

Microsoft 365 User

Provided

Authentication

(hidden by default)

You must first run a utility provided by

Quest Support and enable the setting

EnableUserProvidedAuthentication.

Refer to the Quest Support Knowledge

Base article Enabling User Provided

Authentication in Content Matrix for

details.

* If you are connecting to SharePoint Online using OAuth authentication and you used a custom

domain as the Address, you will also need to check the Override SharePoint Online Tenant

Domain Name and enter the default tenant domain name (which can be found at

https://admin.microsoft.com/Adminportal#/Domains) to allow Content Matrix to route the

request to the proper region.

5. For Connect As, enter/select the login credentials you want to use to connect to the SharePoint

site/server. Use the information in the following table for guidance.

NOTE:  This option is disabled if you selected Microsoft 365 OAuth with MFA Authentication, or

Web Browser Authentication (Not Auto Detected). 

https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
https://admin.microsoft.com/Adminportal#/Domains
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If you want to … Then …

use the current Windows

user's authentication

credential

Select the (default)  <Domain>\<user> radio button.

use different authentication

credentials
· Select the Different User radio button, and

· Enter the applicable user name and Password. 

In cases where alternate credentials are entered, it is

recommended that you select the Remember my password

check box so Content Matrix will automatically remember that

user account password.  This is especially important if you chose

Web Browser Authentication, as credentials must be stored in

the Credential Manager vault before the connection is made. 

6. If you want to Add or Remove certificates to be included when connecting to SharePoint:

a) Select the Included Certificates tab.

Please see the Connecting with Certificates for more details on connecting to SharePoint

instances that require certificates.

b) After all of the desired connection options have been set, for all options tabs, click [OK] to

establish the connection.

If you are making a tenant-level connection, the Limit Site Collections dialog displays, giving you

the option to limit the site collections to include in your connection (which by importing an xml

file with the list of URLs you want to include).  This is useful if the environment you are

connecting to includes a very large number of site collections. In this case, limiting displayed

site collections can improve performance.  Additionally, the Include Microsoft 365 tenant my

site host connection allows One Drives to display under their own top-level connection node

(alongside the main tenant node) with the following URL format: http://[Tenant URL]-

my.sharepoint.com. It is selected by default, but if you want to exclude them from the

connection, uncheck this box.

NOTE:  If you want to View Sample xml, click the link on the dialog.  The xml file you import must

follow the same format as this sample.

7. Either:

§ Click [Yes – Import from XML] to specify the URLs of the sites you want to include in the

connection, then browse/upload the file
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OR

§ Click [No – Continue with Connection] to add all sites within the selected scope to the

connection.

If Content Matrix successfully makes the connection, a new node will appear in the Explorer View (two

if you opted to include One Drives), and you can expand the node(s) and navigate through the

SharePoint objects. 

NOTE:  Should the log file ever show a "could not find site on remote SharePoint server" exception

message when working with CSOM connections, simply restart the CSOM service on all machines

running the Content Matrix console and then rerun the action.

Using Office Microsoft 365 OAuth Authentication to Connect
to SharePoint Online

Microsoft 365 OAuth Authentication is a token-based authentication method that can be used as an

alternative to Standard/ADFS Authentication to reduce throttling.

If Multi-Factor Authentication is set up for the tenant and enabled for the account (as described in the

Microsoft TechNet article SharePoint Online - Microsoft 365: Set up Multi-Factor Authentication), you

can connect using M365 OAuth with MFA Authentication as an alternative to Microsoft 365 Web

Browser authentication.  

Registering the Content Matrix SharePoint Client Application for
OAuth Authentication

The very first time OAuth Authentication is selected, the application Content Matrix SharePoint Client

must be registered for the tenant.

IMPORTANT:  Prior to version 9.2, the Metalogix SharePoint Migration Client application was used

for OAuth Authentication. Jobs created before version 9.2 (including those that use PowerShell) will

continue to use this application (as long as it is still registered in Entra ID).  Starting with version 9.2,

all jobs using OAuth Authentication will use the Content Matrix SharePoint Client application.

Required Permissions

At a minimum, the following permissions are required to register and provide consent for the Content

Matrix SharePoint Client application. 

· For a site-level connection, the account must have a minimum of Site Administrator and

Application Administrator permission roles.

· For a tenant-level connection, the account must have a minimum of Application Administrator

permission role.

https://social.technet.microsoft.com/wiki/contents/articles/36857.sharepoint-online-o365-set-up-multi-factor-authentication.aspx
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Providing Consent to Grant the Application Requested Permissions

The first time a Content Matrix user attempts to connect to SharePoint Online using Microsoft 365

OAuth Authentication, a dialog displays requesting that you grant the permissions that the application

needs to perform migrations.

A Global Administrator can check the Consent on behalf of your organization box, which will prevent

this dialog from displaying for other users.  If the account is not a Global Administrator, the Consent on

behalf of your organization option will be hidden.

IMPORTANT:  If a Global Administrator does not consent on behalf of the organization,  each

Content Matrix user who attempts to connect using Microsoft 365 OAuth Authentication for the first

time must sign in with an account that has the Application Administrator and SharePoint

Administrator permission role.

After [Accept] is clicked, the connection is created (and the application will be registered if it does not

already exist in Entra ID).  In addition, the token cache file ConnectionsTokenCache.dat is created in

the AppData/Roaming/Metalogix folder.  (Note, if you have used OAuth Authentication in an earlier

version of Content Matrix, this file will already exist.)

Completing a Connection to SharePoint Online Using Office 365
OAuth Authentication

When you select one of the Microsoft 365 OAuth authentication types, before making a connection to

SharePoint Online, a pop-up specific to the authentication type will display, as described in the

following table.

NOTE:  If you click the Do not show the message again. box, Content Matrix will continue to use the

selected option and no longer display the pop-up.  You can resume having the pop-up display by

clicking Reset Configuration Options on the ribbon toolbar Settings tab. 

If you selected... Then ...

Auto Detect or

Office365

OAuth/Standard/ADFS

Authentication 

the pop-up will ask you to confirm that you want to use the Microsoft 365

OAuth option.  

Choose [Yes - Use OAuth].
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If you selected... Then ...

Microsoft 365 OAuth

with MFA

Authentication (Not

Auto Detected)              

the pop-up will inform you of some migration limitations associated with

this authentication type.

See the topic Migration Limitations When Using Microsoft 365 OAuth with

MFA Authentication for details.

Signing into your Microsoft 365 Account to Use Microsoft 365
OAuth Authentication

When prompted to sign into your Microsoft 365 account, for Auto Detect or Micrososft 365

OAuth/Standard/ADFS Authentication, you must use the account you specified as the Connect As

account in Content Matrix.  The connection will fail if you try to sign in with another account. (This is

not an issue with Microsoft 365 OAuth with MFA Authentication, which does not use a Connect As

account.)

IMPORTANT:  If you are using OAuth Authentication for the first time, a dialog  may display

requesting that you consent to granting permissions that the application needs to perform migrations.

 To  provide this consent, the account must be an Application Administrator.  (This dialog will not

display if a Global Administrator has granted consent on behalf of the organization.)
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Migrating to SharePoint Online Using the Import Pipeline

Content Matrix currently has limited support for migration using the Import Pipeline.

By default, when the Use Import Pipeline option is checked on the  Folder Options or File Options tab,

the SPO Provided Azure Containers option is selected.  However, if you want to use Azure Private

Containers, you will also need to populate the Azure Storage Connection String field. 

For detailed information on additional system and configuration requirements for using the Import

Pipeline, please see:

· Configuring Settings for Migrations Using the Import Pipeline

· the Content Matrix Performance Optimization Guide for information on configuring Azure Private

Containers for use with Content Matrix.

Objects and Actions Supported Using the Import Pipeline

Supported Objects

The following is a list of objects that can be migrated using the Import Pipeline:  

· Metadata associated with files and folders 

· Overwriting existing files and folders

· Document Sets
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Supported Actions

The following is a list of actions that are currently supported for Import Pipeline migration:

· Paste Files 

· Paste Folder 

· Paste Folder > As Document Library 

· Paste Folder > As Site 

· The following hierarchy-related actions: 

§ Following a Copy File action, Paste Web Hierarchy 

§ Following a Copy Folder action, Paste Folder Hierarchy and Paste Hierarchy

How Content Matrix Determines Import Pipeline Migration Batch
Sizes

When migrating using the Import Pipeline, the EnvironmentSettings.xml file includes configurable

thresholds for batch sizes in both number of items (200 by default) and size (1000 MB by default). 

Content Matrix determines the size of a batch to upload to SPO when the lower threshold is met. 

For example:

· If a library has 20 documents, each of which is 100 MB, Content Matrix will use the size threshold and

will create two batches of 1000 MB.

· If a library has 1000 documents, each of which is 1KB, Content Matrix will use the item threshold and

will create five batches of 200 items.

Refer to the topic Configuration Settings for Migrations Using the Import Pipeline for information on

changing batch sizes and other Import Pipeline configuration settings.

Connecting with Certificates

When connecting to SharePoint, there are two options that can be used to add certificates to the list of

included certificates: Add Installed Certificate and Add Certificate From File. 

SharePoint connections do not actually save the certificate information directly, but instead they save

the data on how to locate the certificates that are in use. This means that if the certificates are deleted

or moved from the referenced location, they will no longer be used with the SharePoint connection

and will have to be manually re-added.

SharePoint Certificates are also supported when generating a PowerShell script. It is still recommended

that the initial SharePoint connection is first configured in the Content Matrix Console. The

recommended process when working with certificates and PowerShell is to first add the connection

(with certificates) in Content Matrix, then set up a migration action in the UI and generate a PowerShell
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script. This will allow you to get the connection format that is required to create a connection in

PowerShell, and it can then be written out manually (if desired).

It should also be noted that the Web Browser Authentication type does not automatically detect

certificates. In order for certificates to be included with this method, they must first be installed in the

appropriate locations in order for a web browser itself to access them.

NOTE:   In some cases, including certificates can potentially result in receiving "maximum request

length" messages when migrating smaller files because the certificate information is included when

the data is being migrated.  

To Add Installed Certificates:

Only "Personal" certificates can be added in this manner because it is the only store that web browsers

use to find certificates when accessing a website.

1. In the SharePoint Logon dialog, select the Include Certificates tab.

2. Click [Add Installed Certificate].

The Add Installed Certificates dialog displays all of the certificates that are installed in the logged

in user account's "Personal" certificate store. 

3. Select any certificates that should be included, and click [OK].

When you return to the SharePoint Logon dialog the selected certificates be displayed in the Included

Certificates list, and they will be included whenever Content Matrix is running an action to or from the

SharePoint connection.

To Add a Certificate from a file:

1. In the SharePoint Logon dialog, select the Include Certificates tab.
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2. Click [Add Certificate From File].

3. Either:

§ enter a filename and location into the Certificate File text box

OR

§ select the Browse button to open a file explorer dialog and navigate to, and select, the desired

certificate. 

4. If a password is required to use with the certificate, enter it in the Password (optional) text box. 

NOTE: When a connection to SharePoint is made, Content Matrix will save the password field for

any certificates so it can re-establish a connection to that SharePoint instance at a later date. If

you are not comfortable with entering the password in the Password (optional) field, you can move

the certificate into the user account's "Personal" folder, and use the Add Installed Certificate

option instead, provided the user account/password is the same.

When you return to the SharePoint Logon dialog, the selected certificate will display in the Included

Certificates list, and it will be included whenever Content Matrix is running an action to or from the

SharePoint connection.

Important Note About Self-Signed Certificates

For security purposes, Content Matrix always attempts to validate a certificate when connecting to a

TLS/SSL site.  Content Matrix cannot validate a self-signed certificate for an on-premises connection

however, and if it attempts to do so you will be unable to complete the connection.  To avoid this

issue, you must change the value of the key BypassCertificateValidation in the

EnvironmentSettings.xml file to True.

Removing Certificates

Any certificates that have previously been added through the two Add Certificates options can also be

removed from the list of Included Certificates. 

To remove a certificate:

1. In the SharePoint Logon dialog, select the Include Certificates tab.

2. Select the certificate(s) that you want to remove.

3. Click [Remove].
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Connecting to SharePoint Using PowerShell
You can create and edit connections to SharePoint using PowerShell.  These connections will display in

the Content Matrix Console.

To access the PowerShell cmdlets for connecting to SharePoint:

Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application

framework.

The following cmdlets are now available:

· Get-MLSharePointConnections

· New-MLSharePointConnection

· Set-MLSharePointConnection

· Remove-MLSharePointConnection

To retrieve information about active connections in the Console:

Select (from the PowerShell ISE Command Window) or enter Get-MLSharePointConnections, then run
the cmdlet.

Details display for each active connection.

To create a new connection to SharePoint:

1. Select (from the PowerShell ISE Command Window) or enter New-MLSharePointConnection.

2. Select or enter the applicable parameters.  Use the information in the following table for guidance.

Parameter Notes

Address

(Required)

The Url of the SharePoint object (Site, Farm, WebApp or Tenant) you

want to connect to.

AuthenticationType

(Required)

Valid values are:

· Windows

· FormsBased

· Adfs

NOTE:  Currently this cmdlet does not support connecting to

SharePoint Online with OAuth authentication.

· UserProvided
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Parameter Notes

NOTE:  UserProvided authentication is used to make site-level

connections to special types of tenants, such as GCC High.  To use

this type of authentication, you must first run a utility provided by

Quest Support and enable the setting 

EnableUserProvidedAuthentication. Refer to the Quest Support

Knowledge Base article Enabling User Provided Authentication in

Content Matrix for details.

ConnectionType

(Required)

Valid values are: 

· Om (local object model)

· MEWS (remote connection using Metalogix Extensions Web

Service)

· CSOM (for SharePoint Online targets only)

TargetType

(Required)

Valid values are:

· Site

· WebApp

· Farm

ConnectAsCurrentUser Use this parameter if you want to make a SharePoint on-premises

connection using the currently logged-in user.

NOTE:  This parameter is not necessary when using an OM

connection, which automatically connects as the currently logged-in

user.

MewsVersion This parameter is only necessary if you want to use an older version

of the Metalogix Extension Web Service.

Password The password of the account making the connection.

RememberPassword This option is recommended to to ensure that the connection

remains active after the PowerShell session has ended.  If it is not

used, the password will have to be re-entered.

Readonly Use this parameter if you want to make a read-only connection to a

SharePoint source.

SkipConnectionCheck Use this parameter if you want to skip validation of the connection.

This is useful if you use a  connections factory and speeds up the

creation of connections.

https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
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Parameter Notes

User The user account making the connection.

3. Run the cmdlet.

Example Scripts:

New-MLSharePointConnection -Address http://win-pvf4cd21m55/ -
AuthenticationType Windows -ConnectionType MEWS -TargetType Site -Password
"Pass" -User Administrator -RememberPassword

New-MLSharePointConnection -Address https://metalogixsoftware-
admin.sharepoint.com -AuthenticationType Adfs -ConnectionType Csom -
TargetType Tenant -Password "Pass" -RememberPassword -User

cpqauser@metalogixsoftware.onmicrosoft.com 

To edit a connection to SharePoint:

1. Select (from the PowerShell ISE Command Window) or enter Set-MLSharePointConnection.

2. Enter the ConnectionId.

NOTE:  You can obtain the ConnectionId by running the Get-MLSharePointConnections cmdlet.

You can now update any of the following parameters, then run the cmdlet:

· ConnectAsCurrentUser (on premises connections only)

· Password

· RememberPassword

· SkipConnectionCheck

NOTE:  Use this parameter if you want to skip validation of the connection. This is useful if you use

a  connections factory and speeds up the creation of connections.

· User

Example Script:

Set-MLSharePointConnection -ConnectionId '91335f9c-9311-439e-9b8e-
78d6f7ef480a' -Password pass -RememberPassword -User Administrator

To remove a SharePoint connection:

1. Select (from the PowerShell ISE Command Window) or enter Remove-MLSharePointConnection.

2. Enter the ConnectionId.

NOTE:  You can obtain the ConnectionId by running the Get-MLSharePointConnections cmdlet.

You can remove multiple connections using the PowerShell pipeline variable.

3. Run the cmdlet.

Example Scripts:
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Remove-MLSharePointConnection -ConnectionID '2F91B056-C300-4263-9FA6-
17EEDF583594'

Remove multiple connections using the PowerShell pipeline variable:

Remove-MLSharePointConnection -ConnectionID '2F91B056-C300-4263-9FA6-
17EEDF583594 ,'2F91B056-C300-4263-9FA6-17EEDF583594','2F91B056-C300-4263-
9FA6-17EEDF583594' | Remove-MLSharePointConnection
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Preparing for Your Migration

8

Content Matrix offers a number of tools to help you locate and organize data and in preparation for

your  migration.  You can:

· Add a Filter to a File Share connection

· Create and manage reports on a File System connection

· Search for SharePoint and File System objects that meet criteria you specify

· Create SharePoint objects

· Delete SharePoint objects

· View StoragePoint details 

Adding a Filter to a File Share Connection

You can add and edit filters on the root connection node to a file share, which will be applied to all sub-

folders and files under that connection. You may for example, only one to include files with a certain

file extensions or files that have been modified after a certain date.  When a filter is added, it will be

applied to any new migration actions that are initiated from that connection. Previously

existing/configured migration actions will not have these filters applied to them.

Filters that are added and applied to a root file share connection will become default settings in the

Filter Options tab. Any changes to Filter Options will be applied to the current migration, but will not

change the filters on the root connection node. 

To apply a File Share Root Node Filter:

1. Select the root connection node for a File Share source.

2. Right-click and choose Add/Edit Filters to display the Filters Configuration dialog.
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|

3. Set desired filters as you would in the Filters Options tab.

4. Click [OK] to close the dialog and use the filters on the File Share source.

NOTE:  Filters will be applied to migration actions as long as Preserve Configuration Options is

enabled, as described below.

To Enable/Disable the File Share Root Node Filter:

1. In the Content Matrix main ribbon, choose Settings > Preserve Configuration Options, which is:

· Highlighted when enabled 

· Not highlighted when disabled

NOTE: When the root node filters are disabled, you can still access the filtering options, but the filters

will not be applied to the migration. 

To remove file share root node Filters:

Use the information in the following table to determine the appropriate action to take.
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If you want to ... Then ...

remove all filters
· in Explorer View, select the node containing the

filters you want to remove, right click and

choose Remove Filters > Remove All Filters

OR

· from the Filters Configuration dialog, click

[Clear All].

remove only standard metadata filters
in Explorer View, select the node containing the

filters you want to remove, right click and choose

Remove Filters > Remove Standard Metadata

Filters.

You will be prompted to confirm the action before continuing.

File System Reporting
You can use Content Matrix to create and manage the following reports on a File System connection:

· The Extended File System Report provides an in-depth view of content within a directory,

including:

§ Number of Files by Extension

§ Number of Files by Size

§ Number of Files by Created Year

§ Number of Files by Modified Year

§ Number of Files by Created Month for Current Year

§ Number of Files by Modified Month for Current Year

· The Simple File Systems Report provides a quick and concise view of the amount of data needing to

be migrated, including:

§ Total Number of Directories - A recursive count of all the directories below the selected node.

§ Total Number of Files - A recursive count of all files in all directories below the selected node.

§ Number of Files by Directory - A count of all files below each directory. This count is limited to a

depth of one level.

· The Migration Report provides a condensed account of what files have been migrated to the

target SharePoint instance, the locations the content has been migrated to, and the date of the

migration. The following data is included:

§ Files Migrated by Site  - An account of how many files were migrated to each SharePoint site,

and the first and last date for migrations to that site.
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§ Files Migrated by Destination Library - A count of the number of files/documents that have

been migrated into each target side document library. Only document libraries that have had

content migrated into them will be listed.

§ Files Migrated by Month - A count of how many files/documents have had content migrated

into them for each month.

§ Files Migrated by Year - A count of how many files/documents have had content migrated into

them for each year.

NOTE:  When configuring the options for the Migration Report, there is an additional check-box

option, Recursive. This check-box option allows for the report generation to run down through

any sub-hierarchy on the target SharePoint side.

Running a File System Report

To run a File System Report:

1. Select the FileShare content on which you want to report; either:

§ a folder node within Explorer View

OR

§ specific items within Items View.

2. Right-click and choose Reporting followed by the type of report you want to run:

§ Extended File System Report

§ Simple File System Report

§ Migration Report

3.  Complete the Reports Options dialog as follows:

a) Enter a Report Name.

b) If different from the default, enter or navigate to the report Output Folder.

Now you can Run the report immediately or Save the report to run at a later time from the Job List

section.

The report will be processed and when complete, the it will be available at the specified output

location. Additionally, more verbose data will be recorded in the Report Manager. The resulting output

file will be a Microsoft Office document type (i.e. docx).
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Using the Search Function

This search feature allows you to do a search through a File Share connection orthe top-level node of a

SharePoint connection for  sites, lists, folders, and files.  Filters can also be applied to the search

criteria using the four main metadata fields (Created, Created By, Modified, Modified By) as well as

content types. The search results can be sorted through, and you can view each returned item's

properties.  You can also run actions on returned items using the right-click menu. 

NOTE:  In addition to the Search feature, the Find feature can be used on File Share sources from the

Items View tab.

To run a Search:

1. In Explorer View, select the connection in which you want to search.

2. Right-click and choose Search.

3. Enter a Search Term/Filter and/or click [Advanced Options] and select any additional criteria you

want to use.
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4. Click [Search].

All the results of the search display in the bottom pane.  Select a result from the list to:

· View the metadata field properties for a selected item (by clicking [Show Properties]).

· Perform an action on a selected item (by right-clicking it and choosing the action).

Working with Search Results

Search results display in the bottom half of the dialog.  You can sort results by any available column.  

To view an object’s Properties:

Select an object in the results list to populate the Search Properties section.
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From Search results, you can perform the same actions that are available in the explorer view for the

selected object type.

To act on a search result:

Select an object in the results list, right click, and choose the appropriate option.  Refer to the

applicable topic in this guide for details.

Importing a Sensitive Content Manager (SCM)
Report for Content Classification
If your organization uses Quest® Sensitive Content Manager (SCM), you can import a .csv file that has

been exported from SCM for migration to a SharePoint document library. Once imported, you can

choose to include the custom column that contains sensitivity search terms and specify a filter that will

include or exclude items that contain a specified search term text string.

NOTE: Only one imported SCM report can exist Content Matrix, but it can be replaced.

For example:

You may want to exclude items that contain highly sensitive information (such as an ID number).

 

You may want to include only items that include an Email.

To import an SCM report:

1. In the Sensitive Content Manager application, download the report that you want to import into

Content Matrix. Refer to the Sensitive Content Manager Administration Guide for complete details.

http://support.quest.com/technical-documents/sensitive-content-manager/administration-guide/reports
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IMPORTANT: For Format, make sure you select Metalogix Essentials.

2. From the ribbon Connections tab, select Import SCM Report.

3. Specify the Report path then click [Import].

When an SCM report has been imported and the file system connection uses the same Source Path that

is specified specified in the .csv file, the following Configuration check boxes will be enabled: 

· on the File Options tab, Migrate matches column.

· On the Filter Options tab, Matches.

To remove imported SCM reports from Content Matrix:

1. From the ribbon Connections tab, select Import SCM Report.

2. Specify the Report Path then click [Clear mapping].

Importing an SCM Report Using PowerShell

You can import an SCM report and remove imported reports using PowerShell.

To access the PowerShell cmdlets for SCM reports:

Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application

framework.

The following cmdlets are now available:

Import-ScmReport

Clear-ScmReport

To import an SCM report:

1. Select (from the PowerShell ISE Command Window) or enter Import-ScmReport.

2. Select or enter the applicable parameters.  Use the information in the following table for guidance.

Parameter Notes

-ScmReportPath The path to the SCM report (as specified in the .csv file).

-v

(optional)

Enable verbose status messaging.

-F

(optional)

Forcefully import the report (This will delete the existing report and

replace it with a new one.)
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3. Run the cmdlet.

Example Script:

Import-ScmReport -ScmReportPath "\\sensitive content\scan results" -v

To remove an SCM report from Content Matrix:

1. Select (from the PowerShell ISE Command Window) or enter Clear-ScmReport. This will clear the

imported SCM report from Content Matrix.

NOTE:  If you want to enable verbose status messaging, you can also enter the -v parameter.

2. Run the cmdlet.

Example Script:

Clear-ScmReport -v

Comparing Source and Target Content

You can use Content Matrix to run a comparison action between a source File Share node, and a target

SharePoint node. This allows you to run a comparison between a File Share source and an existing

SharePoint target to determine if the selected locations are the same (i.e. they are synced).

To Compare source and target columns:

1. In Explorer View, navigate to the desired File System directory node against which you want to run

the compare action.

2. Right-click and choose Compare Directory to display the Compare Directory to SharePoint
Web/List dialog.

3. Select the SharePoint site, list or folder on which to run the compare action.

NOTE:  If you would like to select a different source file system directory that the compare should

be run against, click  Show Explorer  to show only the file system connections.  Click Hide Explorer

to re-display SharePoint connections.

4. Click [OK] to start the compare action.

When the action starts, a Job log will be created. The logs can be viewed (in progress or after the

action is finished) by clicking [Details>>]. After the action has completed a note will be displayed in the

bottom left corner of the dialog stating the number of completions, as well as any warnings or errors

that may have been encountered (if there were any). 

Once the action is complete the logs will display the results of the compare. You can find more details

of the individual results in the Log Item Details dialog, under the Information and Details fields.
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Creating a SharePoint Object

You can create new SharePoint site collections, sites, folders, and lists via the Content Matrix Console.

Creating a SharePoint Site

You can create a new SharePoint site via Content Matrix under an existing site collection or site except

for Database connections and the new site can use any site template that is installed on the SharePoint

environment.

To create a new SharePoint site:

1. In the Explorer View, select the site collection or site under which you want to create the new site.

2. Right-click and choose Create Site.

The Create Site dialog displays, prompting you to enter the Site Title, Site URL Name, Description,

and Template for the new site.

NOTE:  For Site URL Name, it is only necessary to enter the name of the site as you want it to

appear in the URL, not the entire URL path.

Note that if you are migrating to SharePoint Online or SharePoint 2019, the default template is

(modern) Team Site (no Microsoft 365 group).  For SharePoint Online, Content Matrix does not

support connections to tenant-level groups.

3. When you have completed the fields on the Create Site dialog, click [OK].

The new site will now display in Explorer View.
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Create SharePoint Site Collection

 You can create a new site collections on a target SharePoint environment for any SharePoint

connection type, except for database and site connections.

To create a new SharePoint site collection:

1. In the Explorer View navigate to the SharePoint Farm/ Web Application (on premises) or Tenant

(SharePoint Online) where the new site collection should be created.

2. Right-click and choose Create Site Collection.

3. Complete the fields on the Create Site Collection dialog for the selected Mode as you would if you

were creating a site collection from within SharePoint.

NOTE:  In addition, you have the option to create a host named site collection using the Host

Header option.  Refer to the Microsoft TechNet article details about host-named site collections. 

Note that if you are migrating to SharePoint Online or SharePoint 2019, the default template is

(modern) Team Site (no Microsoft 365 group) (STS#3). For SharePoint Online, Content Matrix

does not support connections to tenant-level groups. 

4. After completing the dialog, click [OK].

The new site collection now displays in the Explorer View.

https://social.msdn.microsoft.com/Forums/office/en-US/d549a367-ae78-4ed2-ab0e-826bfb94500f/sharepoint-hosted-apps-on-host-header-based-web-applications-vs-web-application-without-host-header?forum=appsforsharepoint
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Create a SharePoint List

You can create a new SharePoint list via Content Matrix under an existing site as long as:

· the connection type is not read-only, and 

· the new list can use any site template that is installed on the SharePoint environment. 

 If site creation is not valid for the connection type, the option will be disabled.

To create a new list:

1. Navigate to the SharePoint Site where the list/library should be created.

2. Right-click and choose Create List.

3. Complete the Create List dialog as you would if you were creating a list from within SharePoint.

4. After completing the dialog, click [OK].

The new site collection now displays in Explorer View.
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Create SharePoint Folder

You can create a new SharePoint list via Content Matrix under an existing list or library (or within an

existing folder) as long as the connection type is not read-only..  If folder creation is not valid for the

connection type, the option will be disabled.

To create a new SharePoint folder:

1. Navigate to the SharePoint Document Library, List, or Document Folder under which the new folder

should be created.

2. Right-click and choose Create Folder.

3. Complete the Create Folder dialog.   

Note that the Folder Type drop down allows you to select the content type with which to create

the folder. if only one content type exists on that list/library/folder, the option will be grayed out.

There is also a check-box option to overwrite any existing folder that uses the same folder name at

the level the folder is being added.

4. After completing the dialog, click [OK].
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The new folder now displays in Explorer View.

Deleting a SharePoint Object

You can delete one or more SharePoint objects via Content Matrix as long as the connection type is

not read-only. SharePoint objects that can be deleted via Content Matrix are:

· SharePoint Sites

· SharePoint Lists

· SharePoint Document Folders

· SharePoint Documents

· SharePoint List Items

If the action is not valid for the connection type, it will be disabled.

NOTE:  Document versions and list item versions cannot be deleted via Content Matrix.

To delete one or more SharePoint Objects:

WARNING: When this action is used at the site level or below, the object will be deleted permanently

(i.e., it will not be sent to the Recycle Bin).  However, a pop-up dialog will display that allows you to

cancel the action.

1. Select the SharePoint object(s) to be deleted. 

NOTE:  Depending on the type of object, this may be in the Explorer View or in the Items View.

2. Either:

§ Press the Delete key on the keyboard.

§ Right-click on the object and choose Delete [Object].

You will be prompted to confirm the action before continuing.
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Viewing StoragePoint Details

Content Matrix can display the Quest® StoragePoint details for any document items that have been

offloaded to StoragePoint.

To view StoragePoint details:

1. In Explorer View, navigate to a SharePoint Document Library that contains items that have been

offloaded to StoragePoint.

2. Switch to the Items View tab.

3. Select an item, right-click and choose StoragePoint Details. 

NOTE:  The StoragePoint Details option will only be available in the menu if the selected items have

been offloaded into StoragePoint. If the selected item has not been offloaded to StoragePoint the

StoragePoint Details options will not be available.  Only one item can be selected at a time.

The Storage Point Details dialog provides the below information:

§ Address - The web address for the specified item within SharePoint.

§ Endpoint Relative Folder - The folder that has been configured as endpoint for the offloaded

item (i.e. the location of the item in the offloaded storage space).

§ Filename - The StoragePoint file name reference that is left behind in SharePoint after the item

has been offloaded.

4. When finished, click [Close].
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Initiating a Migration
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From the Content Matrix Explorer View, you can "copy" an object from the source connection then

"paste" it to the appropriate location on the target connection.  You will then be prompted to

configure Copy Options.

 

You can:

· Migrate a File Share Folder as a SharePoint site 

· Migrate a File Share Folder as a document library

· Migrate File Share files as SharePoint documents

· Copy a SharePoint site or list as a File Share directory 

Migrating a File Share Folder as a SharePoint Site

Use the Copy as Site action to migrate a File Share folder as a SharePoint site. Depending on the

migration options, any sub-folders will be migrated as SharePoint document libraries, or as sub-sites.

To initiate a "File Share folder as a SharePoint site" migration:

1. In Explorer View, select the source File Share folder to migrate. 

2. Right-click and choose Copy Folder.

3. Select the target SharePoint site node under which you want the new SharePoint site to be

created. 

4. Right-click and choose Paste Folder > As Site option. 

Continue with Configuring Copying Options.

Migrating a File Share Folder as a SharePoint
Document Library

Use the Migrate as Document Library action to migrate a File Share folders as a SharePoint document

library or as a folder within an existing document library. 

NOTE:  Only File Share folders can be migrated as SharePoint document libraries. File Share files and

documents can only be migrated as documents into a SharePoint document library, unless otherwise

specified in the Configure Copy Options - Target Hierarchy Optionstab.
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To initiate a "File Share folder as a SharePoint document library"
migration:

1. In Explorer View, select the source File Share folder to migrate. 

2. Right-click and choose Copy Folder.

3. Select the  target SharePoint site/document library node under which to create the document

library/folder within the document library. 

4. Depending on the target node you chose, right-click and choose either:

§ Paste Folder > As Document Library (to create a document library)

§ Paste Folder (to create a folder within the document library)

Continue with Configuring Copying Options.

Migrating File Share Files as SharePoint
Documents

Use the Migrate Files action to  migrate File Share files as SharePoint documents in a new or existing

document library. 

To initiate a "File Share Files to a new or existing SharePoint
document library" migration:

1. In Explorer View, select the source File Share folder whose files you want to migrate.

2. Switch to Items View. 

3. Select the  files for migration (these files can be multi-selected).

4. Right-click and choose Copy Files.

5. Select the target SharePoint site or existing document library into which you want to migrate the

files.

6. Right-click and choose Paste Files. 

Continue with Configuring Copying Options.

Copying a SharePoint Site or Documents into a
File Share

Use the Copy as File Share Directory action to copy SharePoint sites, document libraries and

documents into a File Share. This allows you to move content back and forth between SharePoint and

the File Share environment. 

You can:



73
Initiating a Migration

Content Matrix File Share Edition

· copy SharePoint sites and document libraries  into a File Share connection as a directory (folder)
while maintaining the existing sub-structure

OR

· copy SharePoint documents as documents under a selected File Share node. 

To copy a SharePoint site or document library as a File Share
Directory

1. In Explorer View, select the SharePoint site or document library that you want to migrate.

2. Right-click and choose Copy Site or Copy List .

3. Select the target File Share directory.

4. Right-click and choose Paste Site > As Directory or Paste List > As Directory.

4. Continue with Configuring Copying Options.

To copy SharePoint documents into a File Share Directory:

1. In Explorer View, select the SharePoint document library that contains documents to be migrated.

2. Switch to  Items View.

3. Select the documents to be copied. 

4. Right-click and choose Copy Selected Documents.

5. Select the target File Share directory.

6. Right-click and choose Paste Documents.

Continue with  Configuring Copying Options.
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Configuring Copying Options
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The Paste [Object] dialog provides a tabbed interface that enables you to configure a migration

according to your specifications.  Available tabs will vary based on the type of migration that you

initiated.

Folder Options

If you chose to Migrate Folders as SharePoint Sites or Document Libraries,complete the Folder

options tab as described below.

To configure Folder Options:

1. If you want to Migrate sub-folders, make sure this box is checked.

NOTE:  If you uncheck this box, only the folder from which you initiated the migration will be

copied.

2. For Replace invalid characters in file names with: select the character that you want to use as a

substitute for any characters disallowed by SharePoint.

3. Select the action that you want Content Matrix to take If a folder with the same name already

exists on the target.  Use the information in the following table for guidance.
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If you to ... Select ...

prevent Content Matrix from copying a folder

from the source if a folder with the same

name already exists on the target (in the same

hierarchy structure)

Do not copy the folder.

allow Content Matrix to overwrite any existing

folders on that target, if they have the same

name as a folder that is being migrated

Overwrite the existing folder.

allow Content Matrix to migrate files and

other folders directly into a folder that already

exists on the target, if a folder with the same

name is being migrated from the source.

Use the existing folder.

allow Content Matrix to migrate a folder from

the source, even if a folder with the same

name already exists on the target.

Copy the folder with a unique filename.

NOTE:   If you select this option, the folder

from the source will be created on the target

using a unique name (typically the original file

name with "_1" appended). For example, if a

folder named "Marketing Programs" is

migrated from the source, and a folder with

the same name exists on the target, then a

new folder will be created on the target called

"Marketing Programs_1", and the contents of

the folder will be migrated into this new folder.

4. Select the Content type options to use when setting the content type for any folders that are

migrated to SharePoint.  Use the information in the following table for guidance. 

If you want to ... Then ...

use the default SharePoint content type for

any migrated folders

select Use default content type (No folder

metadata).

specify the content type that should be

associated with folders when migrating

content.

· Select Use custom content type

AND

· Either:

§ select an available content type from the

drop-down

OR
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If you want to ... Then ...

§ click [Edit Field Mappings] and specify your

own target content type using the

procedure for Mapping Field Types.

5. If you want to migrate to a SharePoint Online target using the Import Pipeline, check the Use

Import Pipeline box and either:

· keep the default option - SPO Provided Azure Containers 

OR

· select Azure Private Containers (if configured), and enter the Azure Storage Connection String

in the following format:

DefaultEndpointsProtocol=https;AccountName={your account name};AccountKey={your

account key}

NOTE:  When using Azure Private Containers, you also have the option to Encrypt Azure jobs. 

(When using SPO Provided Azure Containers, jobs are always encrypted.)

File Options
If you have chosen to migrate folders or files, complete the File Options tab as described below.

NOTE: The Migrate matches column option will only be enabled if a Quest Sensitive Content

Manager (SCM) report has been imported and the file system connection uses the same Source Path

that is specified in the .csv file
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To configure File Options:

1. If you want documents within a folder to be migrated, make sure the Include Files box is checked

NOTE:  This option cannot be unchecked if the migration was initiated for individual files.

2. For Replace invalid characters in file names with: select the character that you want to use as a

substitute for any characters disallowed by SharePoint.

3. If you imported an SCM report and want to migrate the Matches column, which contains the

search terms that were used to identify sensitive content, check the Migrate matches column box.

4. Select the action that you want Content Matrix to take If a file with the same name already exists

on the target.  Use the information in the following table for guidance.

If you to ... Select ...

prevent Content Matrix from copying a file

from the source if a file with the same name

already exists on the target.

Do not copy the file.

allow Content Matrix to copy and update the

metadata for any files that are migrated from

the source, if a file with the same name

already exists on the target

Update the metadata on the existing file.

NOTE:   Any files that do not meet this criteria

will be migrated normally.

allow Content Matrix to overwrite a file on the

target if the file from the source has a more

recent Modified date

Overwrite the existing file if newer.

NOTE:  This behavior will only be used if the

source and target fine names are the same. 

Any other files will be migrated as normal.
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If you to ... Select ...

allow Content Matrix to migrate a folder from

the source, even if a folder with the same

name already exists on the target

Copy the file with a unique file name.

NOTE: The folder from the source will be

created on the target using a unique name

(typically the original file name with "_1"

appended). For example, if a folder named

"Marketing Programs" is migrated from the

source, and a folder with the same name exists

on the target, when this option is selected a

new folder will be created on the target called

"Marketing Programs_1" and the contents of

the folder will be migrated into this new folder.

4. Select the Content type options to use when setting the content type for any files that are

migrated to SharePoint.  Use the information in the following table for guidance. 

If you want to ... Then ...

use the default SharePoint content type for

any migrated files

select Use default content type 

specify the content type that should be

associated with folders when migrating

content.

· Select Use custom content type

AND

· Either:

§ select an available content type from the

drop-down

OR

§ click [Edit Field Mappings] and specify your

own target content type using the

procedure for Mapping Field Types.

5. If you are migrating at the file (not folder) level want to migrate to a SharePoint Online target using

the Import Pipeline, check the Use Import Pipeline box and either:

· keep the default option - SPO Provided Azure Containers 

OR

· select Azure Private Containers (if configured), and enter the Azure Storage Connection String

in the following format:

DefaultEndpointsProtocol=https;AccountName={your account name};AccountKey={your

account key}



79
Configuring Copying Options

Content Matrix File Share Edition

NOTES:  

· When using Azure Private Containers, you also have the option to Encrypt Azure jobs.  (When

using SPO Provided Azure Containers, jobs are always encrypted.)

· Azure/SPO containers do not support migration to document sets. This option will be disabled

if a Migration to Document Set option is selected on the Target Hierarchy tab. 

· If you are copying files as part of a folder migration, this option will instead appear in the

Folder Options tab of the configuration dialog. This option only appears in the File Options

tab for the Paste Files action.

Mapping Field Types

You can create field type mappings for files and folders that are being migrated from a File Share to

SharePoint when you click the [Edit Field Mappings] button from the Folder Options or File Options

dialog.  Mappings are applied to a specific content type on the SharePoint target, which is determined

within the migration's configuration options. 

NOTE:  Mappings are saved as a separate .MLM files, and the mappings are specific to the particular

mapping dialog (Field Types, Users, or Permissions.) they were saved from. 

To configure field type mappings:

NOTE:   Content Matrix supports one-to-one field type mappings between source and target.
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1. From the File drop-down at the top of the Source Fields to Content Type Fields dialog, choose the

appropriate option.  Use the information in the following table for guidance.

If you want to ... Then...

load mappings from a previously-saved

Metalogix Mapping setting (.MLM) file
· choose File > Load.

AND

· Navigate to and open the mapping file to

populate the Mappings dialog

create new mappings go to the next step.

2. Use the information in the following table to determine the appropriate action to take.

NOTE:  You can Filter items in each window to narrow displayed lists.

If you want to ... Then...

manually map each individual source field to

a target SharePoint column
· From the left (File System) window, select the

Item that you want to map.

· From the right (SharePoint Column) window,

select an available Item (for the specified

Content Type).

· Click the Map icon.

have Content Matrix automatically map

source fields to target SharePoint columns
· From the left (File System) window, select the

Item(s) that you want to map.

· Click the Auto icon.

create a new column on the target for any

fields that are selected on the source side
· From the left (File System) window, select the

Item that you want to map.

· Click the Target icon to display the New

Mapping Target dialog.

· Select whether you want the mapping to be a

List Column or Site Column, enter a name

for the column, and choose a column type

from the Group drop-down

NOTE:  These mappings will display in blue in the

right (SharePoint Column) window.

The mappings you create will display in the bottom window.  (Note that you can also Unmap

individually-selected mappings in the bottom window or Clear all mappings from the bottom

window.

3. To save the mappings in the dialog as a Metalogix Mapping setting (.MLM) file, choose File > Save.
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4. Click [OK] once all desired mappings have been made and return to the Configuration Options

dialog.

Permissions Options

With respect to SharePoint migrations, it is important to keep in mind that there are three different

aspects of permissions to be considered:

· Roles - These are also known as permission levels, and are a collection or rights that can be

assigned. In SharePoint it is possible to create custom permission levels (or custom roles).

· Securable Objects - These are basically permissions or rights that can be assigned to an object in

SharePoint. Only users or groups that have the same level of permissions or higher can access the

content holding these permissions.

· Principals - These are permission roles that are assigned to a user or group. In order for a user or

group to have access to a securable object, they would need to have the same permission rights or

higher as the permissions on the object. Users can also have access to secured object if they are a

part of a group that has access through its assigned permission level.

Content Matrix can migrate the Principals, but is currently unable to migrate SharePoint Roles or

Securable Objects.

In the migration process Content Matrix does not actually create any permissions, but instead it maps

the roles between the File Share source and the SharePoint target using it's Permissions Mapping

dialog. Any permissions that are not included in permissions mapping will not be migrated to the

SharePoint target environment.

NOTE:  If you want to use a custom role on the target you must add it to the target before migrating

permissions. However, this does not guarantee that it will be used. If another role on the target has a

closer match with the permission from the source, it will be used instead. 
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To configure Permissions Options:

1. To enable all user and permissions migration options, including the ability to edit users and any user

mappings that have been configured, check the Migrate users using explicit user mappings box.

2. If you want to explicitly map source users to users in the target SharePoint object, click [Edit Users]

and follow the instructions for Mapping Users.

3. If you want to explicitly  map source file system permissions to target SharePoint permissions:

a) Check the Migrate permissions using explicit permission mapping box, and:

b)  Select the applicable option.  Use the information in the following table for guidance.

If you want to ... Select ...

use all Permissions mappings that you define,

regardless of if there is any overlap with

permissions that already exist om the target

Migrate permissions using explicit

permission mappings.

have an "optimization algorithm" run against

user roles on the source and target and apply
Optimize permissions mappings to most

concise permissions set.
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If you want to ... Select ...

the least number of permissions necessary to

map all users from the source

c) Click [Edit Permissions] and follow the instructions for Mapping Permissions. 

4. If you want want Content Matrix to compare permissions on the source with the available

permission levels on the target and automatically map permissions that are not explicitly mapped,

check the Migrate permissions auto-mappings box.  Permissions will be mapped as follows:

NTFS (source) permission SharePoint (target) permission
level 

Full Control Full Control

Modify Contribute

Read Read

Write Contribute

List Folder Content Read

Read and Execute Read

Mapping Users

You can set user and group mappings for migrating content when you click the [Edit Users] button from

the Permissions Options tab. This allows you  to preserve authorship metadata as well as help integrate

the File Share users with the SharePoint permissions model. In some cases it is possible for users to be

automatically imported into the SharePoint environment, however, this is only possible if the File Share

source and the target SharePoint environment are working from the same Active Directory (AD). If this

is not the case, then users would need to be mapped into SharePoint user accounts on the target, and

these accounts must already exist in order for them to be mapped from the source.

NOTE:  If the Author or Editor of any file to be migrated is Builtin\Administrators or BuiltIn\Users, you

must explicitly map the account to a user account in SharePoint for permissions to be applied on the

target. (There is no SharePoint equivalent to a BuiltIn account, so if it is not explicitly mapped it will

not be recognized as a valid user and permissions will not be applied.) 

All user mappings are globally set, so once a mapping is created it will always be used unless removed.

NOTE:  Mappings are saved as a separate .MLM files, and the mappings are specific to the particular

mapping dialog (Field Types, Users, or Permissions.) they were saved from. 
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To map users:

NOTE:   Content Matrix supports many-to-one user mappings between source and target.

1. From the File drop-down at the top of the Active Directory Principal to SharePoint Principal

Mappings dialog, choose the appropriate option.  Use the information in the following table for

guidance.

If you want to ... Then...

load mappings from a previously-saved

Metalogix Mapping setting (.MLM) file
· choose File > Load.

AND

· Navigate to and open the mapping file to

populate the Mappings dialog.

save the mappings in the dialog as a

Metalogix Mapping setting (.MLM) file.

choose File > Save.

set the current permission mappings in the

dialog as the default permission mapping

(regardless of the source/target connections

being used)

choose File > Use as Current Default.

NOTE:  the mappings that display in the dialog

are saved to the local machine, so they are

persistent whenever the application restarts.

2. Use the information in the following table to determine the appropriate action to take.

NOTE:  You can Filter items in each window to narrow displayed lists.

If you want to ... Then...

manually map individual users or groups on
· From the source list, select the Item(s) that
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If you want to ... Then...

the source to a target SharePoint user or

group
you want to map.

· From the target list, select a target Item.

· Click the Map icon.

have Content Matrix automatically map

source users/groups to target SharePoint

users/groups

· From the source list, select the Item(s) that

you want to map.

· Click the Auto icon.

NOTE:  Content Matrix will only map users

automatically if the source and target side

names match, or if the emails match, and the

source and target environments are using the

same AD.

The mappings you create will display in the bottom window.  (Note that you can also Unmap

individually-selected mappings in the bottom window or or Clear all mappings from the bottom

window.

3. Click [OK] once all desired mappings have been made and return to the Configuration Options

dialog.

Mapping Permissions

You can map File Share roles into SharePoint permissions when you click the [Edit Permissions] button

from the Permissions Options tab.  Any Allow Rights or Deny Rights permissions on the source can be

mapped to SharePoint permissions on the target, provided the user or group with the permissions has

been mapped and exists in the SharePoint environment. Content Matrix does not create any

SharePoint permission levels, and can only map roles into existing permissions. 

Role mapping (permissions mapping) is only available if user mapping is enabled.

NOTE:  Mappings are saved as a separate .MLM files, and the mappings are specific to the particular

mapping dialog (Field Types, Users, or Permissions.) they were saved from. 

To map permissions:

NOTE:   Content Matrix supports many-to-one permissions mappings between source and target.
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1. From the File drop-down at the top of the File System Rights to SharePoint Role Mappings dialog,

choose the appropriate option.  Use the information in the following table for guidance.

If you want to ... Then ...

load mappings from a previously-saved

Metalogix Mapping setting (.MLM) file
· choose File > Load.

AND

· Navigate to and open the mapping file to

populate the Mappings dialog.

save the mappings in the dialog as a

Metalogix Mapping setting (.MLM) file.

choose File > Save.

set the current permission mappings in the

dialog as the default permission mapping

(regardless of the source/target connections

being used)

choose File > Use as Current Default.

NOTE:  the mappings that display in the dialog

are saved to the local machine, so they are

persistent whenever the application restarts.

2. Map source roles to SharePoint permissions as follows:

· From the left (File System) window, select the Item(s) that you want to map.

· From the right (SharePoint) window, select an available Item).

· Click the Map icon.

NOTE:  You can Filter items in each window to narrow displayed lists.
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The mappings you create will display in the bottom window.  (Note that you can also Unmap

individually-selected mappings in the bottom window or Clear all mappings from the bottom

window.

3. Click [OK] once all desired mappings have been made.

Target Hierarchy Options
The Target Hierarchy Options tab lets you specify the hierarchical structure of migrated content on the

target SharePoint environment.   

To configure Target Hierarchy - Subsite options:

NOTE:  This option is only available when migrating File Share content as a SharePoint site.

1. If you want to migrate source content into SharePoint sub-sites based on the source File Share's

folder structure, select Migrate files to sub-site based on Source directory structure.

NOTE:  If you also want Content Matrix to use the configured permissions migration settings that

have been set in the Permissions Options tab, check the Copy permissions (based on

configuration in Permissions tab) box.

2. For Set new site template, select from the list of available SharePoint site templates from the

drop-down. 

NOTE: If the target hierarchy is being configured as a separate action (that is, via the Paste

Hierarchy option), you will also have the option to enable the Use Import Pipeline option. For a

full migration, these options are available as either Folder Options or File Options.
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To configure Target Hierarchy - Document Library options:

1. For Migrate to Sub-Folders, select how you want File Share content to be migrated into sub-

folders in a SharePoint document library.  Use the information in the following table for guidance.

If you want to ... Then ...

migrate all files into the document library on

the target without creating any sub-folder

structure

select Do not use folder structure

NOTE:  When this option is selected, all files

will be migrated to the root of the library, even

if there is an additional folder structure on the

source.

migrates any sub-folders into a SharePoint

document library based on the existing folder

structure in the source File Share

select Migrate files to sub-folder based on

source directory structure.

If you also want to migrate permissions to this

new hierarchy structure based on options set in

the Permissions Options tab, check the Copy

permissions (based on configuration in

Permissions tab) box.
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2. If you want Content Matrix to truncate long folder paths or names to avoid migration errors when

the SharePoint character limitation (255)  is exceeded:

a) Make sure the Truncate long path is checked.

b) If different than the default (200), enter a Max Length Before Overflow value, which

determines the folder path length that when reached, will trigger the overflow logic processing.

 You may adjust this value, but make sure it does not exceed 255.

c) If different than the default (5) enter an Overflow Folder Name Length value, which

determines the number of characters (from the first position) that will be used from each

source folder name to construct the folder name in the Overflow.  You may adjust this value,

but make sure it does not exceed 255.

3. For Document Library - Set document library name from:, select which SharePoint document

libraries the source contents (files and folders) will be migrated into on the target SharePoint

instance.  Use the information in the following table for guidance.

NOTE:  These options are only available when migrating content as a SharePoint site or document

library.

If you want to ... Then ...

create a SharePoint document library

with a specified name 

· select Custom Library Name

AND

· if different from the default (Documents) enter a

text you want to use for the library name.

create a SharePoint document library

and name it based on the name of the

source root directory/folder

(For example, if a source folder for the

migration is named "Root1" and this

folder contains two sub folders ("Child1"

and "Child2"), then when this option is

selected, the top level migrated site

("Root1") will have a document library

called "Root1," and each sub-site will

have a document library named after

their source folders. In other words, the

site "Child1" will have a document

library called "Child1" and the site

"Child2" will have a document library

called "Child2.")

· select Source root directory name.

NOTE:  This option is only available when migrating

content as a document library, or if pasting hierarchy

and is disabled if the Use Import Pipeline option is

checked.

create a SharePoint document library

that uses the same name as the source

select Source leaf directory name.



90
Configuring Copying Options

Content Matrix File Share Edition

If you want to ... Then ...

folder containing the documents

4. For Migrate to Document Set, select how you want to  migrate File System content into

SharePoint Document Sets.  Use the information in the following table for guidance.

NOTES:  

· When connected to SharePoint Online, if you have chosen to Use Import Pipeline, these

options are disabled because it is not supported See Objects and Actions Supported Using the

Import Pipeline. 

· Please see Microsoft's Document Sets planning page for more basic details on document sets.

If you want to ... Then ...

migrate content into SharePoint Document

Sets based on a specified name

· select Migrate to Document Set based on

name in text:

AND

· enter the name  you want to use for the

Document Set.

flatten the hierarchical structure of source

content and convert it to a Document Set

select Flatten folder hierarchy and convert

to Document Set.

Filter Options

Filters can be set and applied to all items within the scope of a migration.

NOTE: The Matches option will only be enabled if at least one Quest Sensitive Content Manager

(SCM) report has been imported and you checked the Migrate matches column option on the File

Options tab.

https://learn.microsoft.com/en-us/sharepoint/governance/document-set-planning
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To configure Filter Options:

Check the applicable filter options and enter or select the criteria to apply. 

If you are copying an imported SCM report, checked the Nigrate matches column on the File Options

tab, and want to filter by a search term in the Matches column of the csv file:

1. Check the Matches box.

2. Choose an operator to use to either include or exclude either all or part of the search term.

3. Enter the search term string. (See Importing a Sensitive Content Manager (SCM) Report for Content

Classification for examples.)

NOTE: This option is only available Currently, only one search term search string can be entered.

Link Correction Option
If you want to use Link Correction, make sure the Migrate Source Path (for link correction) box is

checked.

NOTE:  When you check this box, Content Matrix will create a column in the target SharePoint

document library containing the source path of the document.
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Logging Options

Logging Options let you specify the level of detail to include in the migration logs.

To configure Logging Options:

If you want more detailed logging for the migration action, make sure the Enable verbose logging

(may be memory intensive on larger copies) box is checked.
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StoragePoint Options

Content Matrix - File Share Edition has the ability to migrate documents directly into Quest®

StoragePoint, while leaving the endpoint reference in the appropriate SharePoint location. These

options are available through the StoragePoint options tab.

  These options are only available when Advanced Mode is enabled.

When you navigate to the StoragePoint Options tab, a check will be automatically run on the target

SharePoint environment to see if StoragePoint is installed. If StoragePoint is installed, all of the options

within the options tab will be enabled. If StoragePoint is not installed on the target SharePoint

environment, all of the options will be disabled. The StoragePoint detection status will be displayed

next to the StoragePoint found on target: line at the top of the tab window, and the value will either be

Yes or No.

NOTE:  The StoragePoint options will only affect documents and attachments that are being migrated

into SharePoint 2016 or earlier. Other content such as Pages (for publishing sites), will not be

affected. 

To configure StoragePoint options:

1. If an endpoint profile is configured and you want any documents and attachments to be migrated

to SharePoint, check the Add documents directly to StoragePoint if an endpoint is configured

box.

NOTE:  When you check this box, documents and attachments will be added directly through the

StoragePoint API and the end reference will be added in SharePoint.  This helps improve migration

efficiency and can potentially help performance speeds when migrating a large number of

documents and/or attachments.

2. If you want the source File Share location to be converted into a Storage Endpoint location on the

target instead of actually copying the files, check the Link Files to SharePoint by configuring the

source directory as a StoragePoint endpoint.

NOTE:  When you check this box, the appropriate endpoint location link will be added to the

SharePoint environment.  This option's standard use case is for target SharePoint environments

that have StoragePoint installed, but no endpoint has been configured. 

If both StoragePoint options are selected at the same time, the Link Files to SharePoint by configuring

the source directory as a StoragePoint endpoint option will take priority, and overwrite the first

option. This means that the source File Share will be configured as an endpoint for StoragePoint, even

if another endpoint is already configured. If there is a conflict between configured endpoints, the

documents that experience the conflict will not be migrated. 
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Transformations Options

If Advanced Mode and Custom Transformers options have been enabled, you can view, create, and edit

Transformers which, as the name implies, "transform" content during migration.  

There are several built-in, non-editable transformers that Content Matrix uses to process data during

the migration.  Advanced users can also create custom transformers using PowerShell.

The Transformations tab consists of two main sections: Available Definitions and Applied

Transformers For <Object>. The Available Definitions section will list all of the transformation

definitions that are available for the current migration action, in alphabetical order. For example, the

Site definition is available when migrating at the site level or higher. However, if migrating as a

document library or migrating documents, this definition will not be listed.

When one of the Available Definitions items is selected, any transformations that exist/have been

configured within the migrating content will appear. Some of the actions that may be grayed out.

These grayed out items are mandatory transformations that are run during the course of a normal

migration, and these actions cannot be edited or removed. However, they can be reordered by using

the up and down arrows to the right-hand side of the window if you want a transformation action to

occur before a mandatory action. Actions that appear and are not grayed are user added

transformations, and can be moved, edited and deleted at the users discretion.

In some cases, you could add another instance of an existing transformer, and then have it run in two

different locations within the migration process. One could be run in the middle, and it could be run

again just before the end.
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Using PowerShell to Create Custom Transformations

When you select the Add Transformer > Invoke PowerShell script option for an Available Definition,

you can use custom PowerShell scripts to create your own transformations beyond the built-in

capabilities of the Content Matrix. 

Specify when you want the script to run by selecting one of the following options:

Begin Transformation – The transformation script will run before the migration of the affected

objects, allowing you to read and make changes to objects on the source before objects themselves

migrate.  

Transform – The transformation script will run while the migration of the affected object(s) is in

progress.  For example, the user mapping between source and target would be run using the Transform

option.

End Transformation – The transformation script will run after the migration of affected object(s),

allowing you to read and make changes to objects on the target.  

EXAMPLE:  The following Transformer consists of two scripts for disabling and re-enabling the

Required setting for a column list.

· The first script entered into the Begin Transformation tab sets the setting of any columns that are

Required to false before copying begins.

· The second script, entered into the End Transformations tab, sets the setting back to true after

item migration has completed.
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Saving or Running a Migration Job

11

When you finish configuring a migration action, you can run it immediately or save a copy of the

settings to a job file, which displays in the Job List section.  You can then:

· run a migration directly from the Job List section

OR

· create a PowerShell script and schedule it to run as a Windows Scheduled Task

OR

· trigger jobs in the Content Matrix Console to run using PowerShell. 

You can also save the job configuration as a template so that you can preserve and reuse settings for

future migration jobs.

When the migration starts, a status dialog box will appear. The job logs can be viewed (in progress or

after the migration is finished) by clicking [Details>>]. The Status section of the status box will list a live

count for the number of successes, warnings, failures, etc. for the migration. The Progress section of

this dialog will list any completions and the type of completion (Sites, lists, items, users, groups, etc.). A

Migration Completed message will appear when finished. Click Close to exit the status dialog.

Saving a Job Configuration as a Template

You can create job configuration templates for a set of selected settings which can be saved and

reused, including any options that are not normally preserved using the Preserve Configuration

Options option (in the ribbon Settings menu). 

These templates can also be moved to another machine and used with a separate install of Content

Matrix Console (provided that it is the same Edition of Content Matrix, and the same version number or

greater).

To save a job configuration template:

1. After initiating a migration, complete the Configure (Object) Copying Options with the settings that

you want to include in the template.
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2. Click [Save Job Configuration].

Here you can set the display name for the job template. This is not the actual file name, but it is

the name that Content Matrix will use to list the template.

NOTE: In most cases, when a job template is saved by Content Matrix it will be saved to the

following location: 

C::\Users\<User>\AppData\Roaming\Metalogix\Content Matrix Console - <Product> Edition

However, it is highly recommended that you do not interact with this system location. If you are

trying to save a job template so it can be exported to another system the template can be exported

from the Manage Job Configurations dialog.

3. Enter the desired display name value and click [OK] to continue.

Once the save is complete, you will be returned to the Configure <Object> Copying Options dialog

where the migration can either be Run or Saved.

The saved job templates will now be visible in the Manage Job Configurations dialog.

NOTE: If you are looking to save a job template and move it to another system for use, this should be

done using the Export option in the Manage Job Configurations window. Additionally, if you are trying

to Import a job template from another system, this must also be done from either the Manage Job

Configurations dialog or it can be imported when applying a template. 

Applying a Job Template

Any job templates that have been imported or saved, and are available in the Manage Job

Configurations dialog can be applied to another migration of the same type. For example, if migrating

at the site level, you would not be able to use a job template that is created for a migration at the list

level. It would only be able to use a template that migrates at the site level.

The source and target connection types do not apply directly to a job template, so it does not matter if

the connection types for the new migration are the same as the connection types for the job template.

If the connection types are different than any options that are not applicable for the connection types

that are being used will not be available, but all other options will be set.

1. After initiating a migration, click [Open Existing Job Configuration] in the bottom left corner of the

 Configure <Object> Copying Options dialog to display the Select Job Configuration to Apply

dialog. 
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NOTE:  Any options you have specified directly in the dialog will be overwritten once a job template

is applied.

The  dialog lists all of the job templates that are currently available for the migration type (i.e. a

site, list, item, etc. migration), as well as only the templates for the specific Edition of Content

Matrix that is being used. 

2. Select the desired job template and click [OK].

You will be prompted to confirm your action before continuing.  Remember that if you choose to

apply the template, any other settings that you entered directly in the Configure <Object> Copying

Options  will be lost.

The Configure <Object> Copying Options dialog will now reflect all of the template options. Any

additional configuration options can be set or modified, and the migration can continue as normal.

Managing Job Templates

Content Matrix Console job templates can be managed in the Manage Job Configurations dialog. This

dialog allows users to Import, Export, Delete, or Filter any job templates. Below is a breakdown of the

available options in the Manage Job Configurations dialog.

· Import - This button allows users to Import a job template. The imported job template must be

from the same Edition of Content Matrix Console. For example, if users are importing a template

into SharePoint Edition then the template must have been exported from SharePoint Edition.

· Export - This button allows users to Export a job template. The export will create an XML file in a

desired folder location so the file can be copied and placed into another location as needed.

· Delete - This button will delete any selected job templates from Content Matrix Console. When

deleting a template, a confirmation dialog will open and must be confirmed before the templates

are deleted. Deleting will permanently delete the selected templates from Content Matrix

Console.



100
Saving or Running a Migration Job

Content Matrix File Share Edition

· Filter - This is a text box that allow users to enter a value that Content Matrix will filter the job

templates against. The filter will only display items that contain the specified value. There is a Filter

icon to the right-hand side of the filter text box. Clicking this icon will apply the filter text value to

all of the job templates listed in the Manage Job Configurations dialog, so only the templates that

contain/include the matching filter value will be shown. Filtering can be cleared by removing the

text value from the filter text box, and clicking the filter icon button.

Exporting a Job Template

To export a job template:

1. In Content Matrix's ribbon toolbar, switch to the Settings tab and click [Manage Job

Configurations] button to display the Manage Job Configurations dialog.

2. Select the template you want to export then click the Export button at the top of the Manage Job

Configurations dialog, .

3. Navigate to the desired folder location where you want to save the job template, enter a File

name, and click [Save]. 

4. The job template XML file will be saved to the selected folder location, and Content Matrix will

return to the Manage Job Configurations dialog. Any additional importing, exporting, or deleting of

job templates can be done. Click Close to return to the main Content Matrix window.

Now that the job templates have been exported and saved to a folder location they can be manually

moved to another location as required.
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Importing a Job Template

Only templates that have been created from the same Edition of Content Matrix Console can be

imported. For example, a job template from SharePoint Edition cannot be used in Public Folder Edition,

it can only be imported into SharePoint Edition. 

To import a job template:

1. In Content Matrix's ribbon toolbar, switch to the Settings tab and click [Manage Job

Configurations] button to display the Manage Job Configurations dialog.

2. Click the Import button at the top of the Manage Job Configurations dialog, navigate to the folder

location for the template XML file, then click [Open].

The job template will be added to the list of templates in the Manage Job Configurations dialog.

The template will be listed using the same Display name that was used when the task was created

on the original system, and will not have its file name displayed. 

The job template is now imported and can be applied to any migration.

Importing and Exporting Migration Jobs

From the Job List, you can export a job to an xml file.  This functionality allows you to:

· Copy a job from one instance of Content Matrix to another (as long they are for the same Edition).

· Manually modify a job, then re-import it. 
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To export a job to an xml file:

1. In the Job List, select the job(s) you want to export.

NOTE:  If you select multiple jobs, they will be saved to a single xml file.

2. Right-click, and choose Export selected job to xml. 

The xml file will automatically open in whatever program is set as the default application for xml

files, and it can be saved to any desired location.

To import an xml file to the Job List:

1. Make sure the file you want to import uses a different Job ID than any existing jobs (this should

only be an issue if the xml file was previously exported from the same Content Matrix Console).

NOTE: If you import an xml file via the Console and the file being imported contains the same Job

ID as an existing Job, then the import will fail.  However, you can create a duplicate job with a

different Job ID if you import the xml file using PowerShell.

2. From the Job List menu, choose File > Import Jobs From Xml.

3. Select the xml file to import. 

If the import is successful, the job will be listed in the Job List section.  If unsuccessful, an error

message will be displayed.

Refreshing the Jobs List
NOTE:  The refresh is applied to whichever job list Content Matrix is currently connected to. 

To refresh the Job List:

1. From the Manage Queue dialog, select a job in the Job List.  The row selector icon and the

highlighted row indicates the selected row.

2. From the Job List menu bar, choose File > Refresh. 

If the status of the job has changed, the Status value will indicate the new status of the job.

Creating and Running a PowerShell Script from
the Jobs List
 In order to create a PowerShell (PS) script for Content Matrix, a job list (or batch file) must first exist in

the Job List section of the Content Matrix Console.  Once created, it can be run from the PowerShell

console or scheduled to run as a Windows Scheduled task.

NOTES: 

·  It is recommended that the connections to the source and target environments have the
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Remember my password check-box selected. This is to ensure that the PowerShell scripts will be

able to establish a connection to both the source and target environments when they are being run.

If a password is required and this check-box is not set, the migration will fail. However, users can

manually enter this value into the PowerShell script itself if the option was not checked when the

script was first generated.

· Web Browser Authentication, O365 Web Browser Authentication, and Forms-based Authentication

are not supported for running a job using a PowerShell script.

Refer to the Quest Support Knowledge Base article Connections that will work with PowerShell and

Connections that doesn't work with PowerShell for complete details.

To create a PowerShell script:

1. In Job List, and select the job (or jobs) that you want to run in PowerShell.

2. Click the Generate PowerShell Script button in the Job List tool bar, or right-click on one of the

items and select Generate PowerShell Script from the context menu. 

3. From the drop-down, choose the appropriate option.  Use the information in the following table for

guidance.

If you want to generate a PowerShell script

for scheduling …

Choose …

that can be used only by the currently logged

in User Account on the machine it is

generated on

For Current User and Machine.

NOTE:  Any PowerShell scripts that are generated

for scheduling through this option can only be run

by the logged in user on the machine they were

generated on.

that can be used by any User account on the

machine it is generated on

For Local Machine.

that can be used by any User account on any

machine that has the certificate that is

specified when the script is created

For Certificate.

When you save the PowerShell script using this

method you will be prompted to select a security

certificate that exist on that machine. The

selected certificate will be required on any system

that attempts to run the script at a later date.

https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
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If you want to generate a PowerShell script

for scheduling …

Choose …

Once the PS script generation type is selected, Content Matrix Console will generate a PS script for

the select Job, which will be written to a Microsoft Notepad file. If multiple jobs are selected they

will all be written to the same file.

4. Choose  File > Save As... and select any desired save location for the PowerShell script. Give the file

any name you want, but change the file type to .PS1.

The PowerShell (PS) script itself contains five sections. They are:
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· Section 1 - This first section at the top (starting with an "if" statement) runs a check in the PowerShell

console to make sure that the Metalogix snap-ins have been added. If they are not found then it will

add them to that instance of the PS console.

· Section 2 - Load Configuration settings - This section will find and load all of the Content Matrix

client application configuration settings into the PowerShell script. These are the client application's

environmental settings and not the migration/action settings.

· Section 3 - Load source - This section will load all of the data for the source environment

connection.

· Section 4 - Load target - Similar to the previous section, this will load target environment's

connection information.

· Section 5 - Run the action - Last is the "Run the action" section. This last section will contain all of

the other data for the migration, such as the type of migration (i.e. a site migration, list migration,

item migration, etc.) and all of the settings and configurations for the migration/action that is being

run. This includes things like settings for versions, content types, permissions, etc.

Now you can run or schedule the PowerShell script.

Running a PowerShell Script

Once a PowerShell script has been created, you can run it from the PowerShell console.

To run the PowerShell script:

NOTES: 

·  If you have more than one edition of Content Matrix, only one edition can be run per PowerShell

session.

· If Content Matrix settings  is changed, in order to apply new settings all PowerShell sessions must be

restarted.  

To add the PowerShell cmdlets for the application framework:

1. Open a Powershell ISE or PowerShell console session.

2. Run the Add-PSSnapin command and by pasting in the following text:

 if( $PsVersionTable.PSVersion.Major -lt 3 ) { Write-Host "Windows
PowerShell Version 3.0 or later needs to be installed in order to run

Content Matrix PowerShell scripts."; exit; }if ( (Get-PSSnapin -Name

Metalogix.System.Commands -ErrorAction SilentlyContinue) -eq $null )

{ add-pssnapin Metalogix.System.Commands | out-null }if ( (Get-PSSnapin -

Name Metalogix.File.Commands -ErrorAction SilentlyContinue) -eq $null )

{ add-pssnapin Metalogix.File.Commands | out-null }if (Get-Command Set-

MetalogixJobPrerequisites -ErrorAction SilentlyContinue){ Set-

MetalogixJobPrerequisites -Value "Content Matrix Console - File Share

Edition" }
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2. Set the directory to the location where the PowerShell script is located.

3. Enter the name and extension of the PowerShell Script (at its specified location), and the script will

run.

In the case that you are running a script from the same directory you would use the format: .

\[ScriptName].ps1. So if your PowerShell scrip was named "ResourceScript.ps1" then you would

enter: .\ResourceScript.ps1 into the window, and the script would run.

If the script is in a different directory, you would enter the location of that directory relative to

your current location, followed by the script name. For example, if your prompt is at the "C:\" drive

and your PowerShell script, named "ResourceScript.ps1" is on the desktop you would enter: C:

\Users\[User]\Desktop\ResourceScript.ps1, and the script would run.

NOTE:  In some cases the Execution Policy may prevent you from running a PowerShell script. In this

case you will likely see the message: [Script].ps1 cannot be loaded because the execution of scripts is

disabled on this system. Please see "get-help about_signing" for more details. In this case, running the

command: set-executionpolicy RemoteSigned should change the existing script policy to allow you to

run these scripts for your location. It is advised that you check with your System Administrators

before doing this to ensure that no Company Policies are being broken by this action. If this is an

action you need to take, you should only need to run this command once.

The migration will begin, and any warnings and/or errors that are encountered in running the script will

be displayed in the PowerShell window.

Scheduling a PowerShell Script to Run as a Windows
Scheduled Task

Once a PowerShell script has been created, you can run any migration job as a scheduled task on the

system that the client application is installed on. This can be any migration action that exists in the Job

List section, whether it's a migration job that was saved or a job that was previously run. 

The Generate PowerShell Script option saves configurations for the selected job(s) as a PowerShell

script. After the script has been saved, you must create a Windows Scheduled task directly in the

Windows Task Scheduler.

Once these jobs have been created as scheduled tasks they can no longer be viewed (as scheduled

tasks) in Content Matrix.  If you want to make any other modifications or remove the task you can do

so directly in the Windows Task Scheduler. If a task has been scheduled, the system will be able to run

the task at the appointed time(s), regardless of whether Content Matrix client application is open.

To schedule a PowerShell script to run via the Windows Task
Scheduler:

1. On the system where the scheduled task will run, open the Windows Task Scheduler.

2. Choose Actions > Create Task.

3. Enter a task Name and Description.
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4. In the General tab, go to Security options and specify the user account that the task should be run

under. Change the settings so the task will run regardless of whether the user is logged in.

5. Select the Triggers tab, and click [New] to add a new trigger for the scheduled task. This new task

should use the On a schedule option. The start date can be set to a desired time, and the

frequency and duration of the task can be set based on your specific needs. Click [OK] when your

desired settings are entered.

6. Select the Actions tab and click [New] to set the action for this task to run. Set the Action to Start a

program.

7. In the Program/script box enter "PowerShell."

8. In the Add arguments (optional) box enter the value ".\[Your PowerShell Script Name]." For

example, if your PowerShell Script is named "Migration1.ps1" then you would enter ".

\Migration1.ps1" as the value.

9. In the Start in (optional) box, add the location of the folder that contains your PowerShell script.

NOTE:  The location used in the Start in box will also be used for storing the scheduled task run

times, the job history for the copies, and any additional logging that may occur.

10. When all the desired settings are made, click [OK].

11. Set any other desired settings in the Conditions and Settings tabs. 

12. Once all the desired actions have been made (or added), click [OK]. 

The task will be immediately set, and is ready to run.

After the scheduled task has run, a new entry will be added to Content Matrix's Job List section.

Triggering a Job in the Content Matrix Console
to Run Using PowerShell
As an alternative to generating a PowerShell script, you can use PowerShell to trigger jobs that have

been created in the Content Matrix Console.

To access the PowerShell cmdlets for triggering jobs to run:

Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application

framework.

The following cmdlets for running jobs are now available:

· Get-MLJobs

· Invoke-MLJob

To retrieve information about jobs in the Console:

1. Select (from the PowerShell ISE Command Window) or enter Get-MLJobs.
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2. (Optional) Enter one or more of the following parameters if you want to filter jobs:

· JobNameOrTitle 

· JobStatus 

· Source 

· Target

NOTE:  If you do not apply filters, all jobs in the Console will be retrieved.

3. Run the cmdlet.

Example scripts:

Get-MLJobs

To run one or more jobs:

1. Select (from the PowerShell ISE Command Window) or enter Invoke-MLJob.

2. Select or enter additional parameters.  Use the information in the following table for guidance.

Parameter Notes

JobID
· You can obtain the JobId by running the Get-MLJobs cmdlet.

· You can run multiple jobs using the PowerShell Pipeline variable.

JobStatus Valid statuses are:

· Running

· Not Running

· Paused

· Aborted

· Aborting

· Done

· Warning

· Failed

· Queued

· Triggered

· Cancelling

· Cancelled

Quiet Use this parameter if you do not want to display a status of the job as it

is running.

RunRemotely Use this parameter if you want to submit the job for Distributed

Migration.

NOTE:  This option is valid for SharePoint Edition only.

3. Run the cmdlet.
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Example Scripts

Invoke-MLJob -JobId '92416012-4b69-4d4e-b3c2-984cde279909'

Invoke-MLJob -JobStatus Failed

Run multiple jobs using the PowerShell pipeline variable:

Invoke-MLJob -JobID 'c8176dd1-f1fd-484c-bc66-c002f5406f05' -RunRemotely
'5ca0d97f-4d1d-445f-a6d9-3292abe89a6f', '0a2e0874-a759-46f4-b459-
bb98ec2991ad' | Invoke-MLJob '30bf6d71-0a28-4012-b612-2d22562b5b46',
'0b094765-46e0-4919-8922-cc5fe841e1f5' | Invoke-MLJob -Quiet
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Job Log Files
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You can view the progress of a migration tab in real-time via interactive log files. The logs are fully

searchable.

To view an interactive log:

After starting an action, click Details>> in the progress dialog box. 

NOTE:  All logging in Content Matrix is done through jobs. If a job list is deleted from the Job List, all

logging for those actions will also be deleted. There is no backup for the job lists, unless the job is

manually saved to another location. Once a job list is deleted, all logging for the actions within that

job list are gone. Content Matrix will automatically hold any job lists created through any copy or

compare actions, in the Job Lists section, and these job lists can only be deleted through the

appropriate Delete commands. The job lists can also be manually selected and saved through the Job

list section.

There are two types of jobs in Content Matrix:

A job list is a collection of job items. A Job list is created for each copy or compare action that is made.

Any "Copy" action/job that is in the Job List section can be used as the base of an incremental copy job.

Job items can be viewed in the Log Viewer, by opening a job list. There are three basic ways to open a

job list to access the Log Viewer:

· Double-click on a job list.

· Select a job list, then in the Job List section of the toolbar click View Log.

· Select a job, right-click, and choose View log.

Job items are job files, or logging, for individual items within the scope of an action. For example, if a

File Share folder is copied as a SharePoint site, there would be a job item for adding each SharePoint

list and each item in that list, and one job item for adding or creating each site or sub-site. If a File

Share folder with 5 documents is copied, then there would be a job item for adding/creating the list,

and then one job item for adding each of the documents.
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Job items are job files, or logging, for individual items within the scope of an action. For example, if a

SharePoint site is copied, there would be a job item for adding each list and each item in that list, and

one job item for adding or creating each site or sub-site. If a SharePoint list with fie documents is

copied, then there would be a job item for adding/creating the list, and then one job item for adding

each of the documents.

From the Log Viewer you can select and view any job items that exists within that job list.

NOTE:  Some actions in Content Matrix have the ability to run with Verbose Logging. This option will

increase the size of the log file.

Log Item Details

To view Log Item Details:

1. From the Log Viewer, select the item whose details you want to view.

2. Use one of the following options:

§ Double-click on the item.

OR

§ Right-click and choose View Job Item.

OR

§ If the job is currently running, click Details>>.
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The Job Details dialog contains the following information:

· Operation - The last operation performed on the item.

· Status – The status of the item. If a compare action is being performed then this could be:

completed, different, or missing.

· Item Name - For items, the Item ID. For documents, the Filename.

· Time Started – The time the action for the item was started.

· Time Finished – The time the action for the item was finished.

· Bytes Copied – The  bytes (B) that were copied in the action. This will be displayed in KB in some

cases.

· Source - The Source URL for the item.

· Target - Target URL for the item.

· Information - Provides an informational message about the item, such as. This section will provide

a description for any different and/or missing attributes/metadata for an item.

· Details View - Any errors that were encountered with the item when an action was performed.  

· Content Comparer tab - Any differences between Source and Target content (from a compare

action). You can display this information in either a Grid View, which displays a metadata property

grid for the item, or as a Text View, which displays a XML text format of the item.  This option is

most useful if Verbose Logging has been checked
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You can also:

· Use [Search KBs] to have Content Matrix query the Quest Support Knowledge Base for relevant

articles if you selected a failed item.

· Use [Copy] to copy all of the item information and details (including the Details tab) into the

system’s clipboard.  You can then paste the information when it can then be pasted to another

location. When pasted the information will look similar to that of the actual Log Item Details

dialog. This can be used for easy copy/pasting of an items migration log details.

· Use [Prev] and [Next] buttons to move to the previous or next item on the list (if applicable).

Exporting Jobs to an Excel File

You can export a selected job or multiple jobs from the Job List section into a Microsoft Excel file. The

export will include all of the operations within each job (whether it is a migration action or some other

action), and their details. This is to help users better understand their migration data and results, and

provides another way to review the resulting logs.

In addition to the log details that are provided, there are also a number of tables and charts that can be

accessed in different tabs within the Excel file. These tables and charts will help breakdown the

information in a more visible manner.

To export one or more jobs to an Excel file:

1. In the Job List, select the job(s) you want to export.

2. Use one of the following options:

§ From the Job List menu, select Export Excel 

OR

§ Right-click and choose Export selected job to Excel.

3. Save the file to the desired location.

By default the Excel file will open after it has been created. This process may take a few minutes

depending on the size of the selected job(s) and the number of actions in the log(s).

Procedure for exporting one or more jobs to an Excel file

1.

Information  in Exported Excel Files

When an Excel file is exported from the Content Matrix Job List there are a number of page tabs that

can be viewed. Each page tab will display a different set of data, and some of these tabs will also

display pivot graphs (with pivot tables behind them).

https://support.quest.com/metalogix-content-matrix/kb
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NOTE: The data within all of these Excel tabs (both the tables and the graphs) should only be

considered a starting point when looking at your migration data. You can modify the existing graphs

through various methods, such as applying filters, changing the data values, etc.  You can also take the

"raw" data from the LogItems tab and use it to create your own graphs or sets of data as required.

The exported file contains the following tabs:

· Jobs - All of the specific jobs that are included in the export. This includes migration jobs as well as

other actions.

· LogItems - All of the operations that have been run by Content Matrix and provide all of the logging

details that are available in the Log Viewer and Log Item Details windows. Some examples of these

operations are: adding lists, adding content types, copying documents, adding users, updating lists,

etc.

· Error Rates - A a graph that represents the number of errors and warnings that Content Matrix

encounters during a migration on a "per minute" basis. The vertical axis will list the number of

errors/warnings that are encountered (at the specified time), and the horizontal axis lists the

amount of time (displayed in a "per minute" value). The horizontal axis can also be changed to

display in month, day, or hour time values as well. Below the graph is a table that provides a

different view of the same error/warning breakdown.
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· Operation Counts - The number of operations/actions that are run over a period of time. Some

examples are: copying sites, copying lists, copying documents, adding SharePoint groups, adding

users, copying permissions, etc., and each operation has its own line representation on the graph.

The vertical axis lists the number of operations that are running (at the specified time), and the

horizontal axis lists the amount of time (this is displayed in a "per minute" value). The horizontal

axis can also be changed to display in month, day, or hour time values as well. Below the graph

there is a table that provides a different view of the same migration operation data.

· Operation Duration - The total duration of time for each operation/action type against the total

migration time.   This is potentially the most confusing graph to read in the exported Excel file. The

vertical axis lists the total duration time for each action. This is determined by finding the

difference between each operation/actions Time Started and Time Finished values, and then
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adding the totals together for all of that operation/actions of that type that are running. This is

then displayed against the horizontal axis which lists the time (displayed in a "per minute" value) for

the migration. The horizontal axis can also be changed to display in month, day, or hour time values

as well. Below the graph there is a table that will provide a different view of the same migration

data.

An example of how to read this graph is: if at minute 25 (of the hour, not the 25 minute of the

migration) a large number of small documents are copied and completed (all in the 25th minute),

then at minute 25 in the graph there will likely be a spike in the "duration time" for the "Copying

Document" operation/action. If each document was copied in 2 seconds, and there were 41 small

documents, then the Sum of Duration value would be listed as 82 seconds (or 0:01:22). So the

results in the graph would show a spike for the Copying Document operation/action and minute

25, with a value of 0:01:22.

· Operation Throughput – The  amount of data/throughput (in MB) that is migrated on a "per

minute" basis. The vertical axis lists the amount of data that is being pushed through Content

Matrix for a given operation (at the specified time), and the horizontal axis lists the time (displayed

in a "per minute" value) at which that the action was performed. The horizontal axis can also be

changed to display in month, day, or hour time values. Below the graph there is a table that will

provide a different view of the same throughput data.
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Copying Job Logging to Other Applications

It is possible to copy the results of migration jobs from log files to other applications. This can be

beneficial if you want to keep track of copy or incremental information outside of Content Matrix, or

want to manipulate the information for reporting or retention purposes. The log information is copied

as text, to the clipboard, and can then be pasted within any other application that allows text pasting.

For example, if a copy action was made, the logging can be copied into a Word file, or into an Excel

spreadsheet, then saved. 

NOTE:  Only the end results of the total action will be copied.

To copy the logging for a job list:

1. Select a job from the Job List.

2. Right-click, and choose Copy selected job to clipboard (alternately Ctrl+C can be used).

3. Open the desired target program (for example: Microsoft Word, Microsoft Excel, Notepad, etc),

then paste the content into the application (Ctrl+V, or the paste command in the application

itself). 

NOTE:  The logging for each action within the list must be copied separately.

To copy the logging for job items:

· Select the desired job list or job item(s) that the logging is to be copied from, and open the job list

to access the Log Viewer.

· Select any job items that are to be copied. Single or multiple items can be selected in the Log

Viewer. In order to copy the logging for the entire job, all job items in the Log Viewer must be

selected.
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· When all of the desired items are selected, right-click on one of them, and select Copy Log Items to

Clipboard, and select to either copy them with, or without details. The Details are a set of extra

columns that are added to the logging. These columns are typically: Details, SourceContent, and

TargetContent. These columns do not always contain extra information. The default copy option

(Ctrl+C) is to copy the logging without the Details.

Creating a Support Zip File

You can generate a zip file of data associated with a single migration job to help Quest Support

facilitate troubleshooting.

The high-level data collected in the zip file includes:

· Application Settings files.

· Product information (product version, license, etc.).

· Information about the job (what action settings were set, the job log, etc.).

IMPORTANT:  Sensitive Information

Please review the contents of the zip file before sending it to Support.  While this feature attempts to

only collect non-sensitive data, no guarantees can be made - it is up to you to ensure that any files in

the zip folder are stripped of any confidential data. Regardless, Quest assures that the contents of the

zip file will only be used for troubleshooting the associated support ticket.  For added security, Content

Matrix removes the encrypted password and token information from the file.  

NOTE: Because passwords are removed, if you try to import a job from a Support zip file and there is

no active connection to both the source and target, the import will fail. It is recommended that you

create xml jobs using Export to Xml functionality instead of using the xml file generated by the Create

https://support.quest.com
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Support Zip File operation. Refer to the Knowledge Base article While Importing a Job from a Support

Zip File, the error “Could not load data: A password is required” is generated (4369247) (quest.com)

for details.

To create a Support zip file:

1. In the Job List, select the job for which the zip file is to be generated.

2. Use one of the following options:

§ In the main ribbon, click the Help tab, then Create Support Zip File.

§ Right-click and choose Create Support Zip File.

3. Save the file to the desired location using the desired file name.

4. If you wish to review the zip file for sensitive information, click Yes to open the zip file. Once you

are satisfied with the contents of the zip file, it can be sent to Quest Support to aid in

troubleshooting.

https://support.quest.com/kb/4369247/while-importing-a-job-from-a-support-zip-file-the-error-could-not-load-data-a-password-is-required-is-generated
https://support.quest.com/kb/4369247/while-importing-a-job-from-a-support-zip-file-the-error-could-not-load-data-a-password-is-required-is-generated
https://support.quest.com
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Content Matrix can generate PowerShell scripts to be used to migrate SharePoint content through the

PowerShell command window.  You can also use PowerShell to perform other actions, including:

· connecting to SharePoint

· triggering a job in the Content Matrix Console to run

The Content Matrix PowerShell Console shortcut is added to the same Start Menu folder location

where the to Content Matrix Consoles are placed after installation. The same PowerShell console can

be used for any edition, as long as the edition-specific snap-ins are used.  You can also use a standard

PowerShell console or PowerShell ISE.

Content Matrix PowerShell Commandlet List

Content Matrix can generate PowerShell script for you, for any migration action that is available

through it. The below cmdlets are used in the generated PowerShell script, but can also be used to

write your own script, should you desire to do so. For more information on each cmdlet, simply type

get-help [cmdlet]. For example, if you want more information on Copy-MLSharePointList cmdlet you

would enter get-help Copy-MLSharePointList, followed by the Enter (return) key.

Below is a list of the available cmdlets (and their parameters), broken up into the available commands

for each snap-in.

Adding PowerShell Snap-Ins for the Application Framework

Whenever a new PowerShell session is launched, the edition-specific snap-ins must be added before

you can perform a Content Matrix action.

NOTES: 

· If you have more than one edition of Content Matrix, only one edition can be run per PowerShell

session.

· If Content Matrix settings or a connection to a Distributed Database change, in order to apply new

settings all PowerShell sessions must be restarted.  
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To add the PowerShell cmdlets for the application framework:

1. Open a Powershell ISE or PowerShell console session.

2. Copy and paste the PowerShell snap-ins from the Quest Support Knowledge Base article located at

https://support.quest.com/content-matrix/kb/333879.

Metalogix.Jobs.Reporting.Commands

Export-JobHistory

· SqlCeDbFilePath - Specify the path to the SQL database file that contains the Job History data.

(Mandatory)

· ServerName - The name of the SQL Server. (Mandatory)

· DatabaseName - The name of the Job History database. (Mandatory)

· AuthType - Indicates whether to use Integrated (Windows) or SQL Authentication. If not specified

will Integrated Authentication will be used.

· Username - Specify the username for SQL Authentication.

· Password - Specify the password for SQL Authentication.

Metalogix.SharePoint.Commands

Add-MLSharePointSiteCollection

· WebApplicationName - Name of the Web Application to Create the Site Collection in. Web

Application must exist in the specified Target. (Mandatory)

· WebTemplateName - Web (Site) Template to use for the Site Collection. Web (Site) Template must

exist. The value must be in the form name#configuration. E.g., STS#1 for Blank Site (Mandatory)

· Language - Language to use for the Site Collection. Can be Language Code (LCID) or Language

Name. Language must exist in the specified Target. (Mandatory)

· Title - The Title for the Site Collection. (Mandatory)

· Description - Description for the Site Collection.

· Path - Managed Path for the Site Collection. Include forward-slash characters where required. E.g.,

"/sites/" or "/sites/". (Mandatory)

https://support.quest.com/metalogix-content-matrix/kb/333879
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· URL - Server Relative portion of URL solely used to identify the Site Collection itself. E.g.,

"TestSiteCollection" (Mandatory)

· OwnerLogin - Domain and username to be used as the Primary Administrator for the Site Collection.

E.g., "sampledomain\sample.user" (Mandatory)

· SecondaryOwnerLogin - Domain and username to be used as the Secondary Administrator for the

Site Collection. E.g., "sampledomain\another.user"

· ContentDatabaseName - Content Database Name to use. Not specifying this value will use the

default content database (auto detect).

· SelfServiceCreateMode - Allow users without Farm Administrator privileges to add the Site

Collection.

· SetSiteQuota - Set Quota for the Site Collection.

· QuotaMaximum - Limit site storage to maximum size (Mb). SetSiteQuota must be set to true and

SelfServiceCreateMode should be false. Mutually exclusive with QuotaID.

· QuotaWarning - Send a warning email when the site storage reaches this size (Mb). SetSiteQuota

must be set to true and SelfServiceCreateMode should be false. Mutually exclusive with QuotaID.

· QuotaID - Use Quota Template. Can be the integer ID or the string name of the Quota. SetSiteQuota

must be set to true and SelfServiceCreateMode should be false.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-Permissions

· Name - The name of the user or group you wish to assign a permission level to. (Mandatory)

· PermissionLevel - The name of the permission level you want to grant the specified user or group.

(Mandatory)
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· Recurse - A flag that indicates the given permissions level should be granted to the given user for

each item below the target which has unique permissions.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointFolder

· Name - The name of the folder to be created. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointList

· Name - The name for the new list. (Mandatory)

· TemplateName - The numeric code of the template to use. (Mandatory)

· Description - A description of the list.
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· Title - The title for the new list.

· IsOnQuickLaunch - Indicates if the list should be added to the quick launch.

· HasVersions - Indicates if the list should enable major versions.

· HasMinorVersions - Indicates if the list should enable minor versions.

· RequiresContentApproval - Indicates if the list should require content approval.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointSite

· URL - The URL name for the new site. If not specified, it will be automatically generated from the

given name.

· Name - The name for the new site. (Mandatory)

· TemplateName - The name of the template to use, either in [Name]#[Config] form or by the name

of the STP file. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.
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· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Clear-GlobalMappings

· ClearGuidMappings - Indicates that global GUID mappings should be cleared.

· ClearURLMappings - Indicates that global URL mappings should be cleared.

· ClearUserMappings - Indicates that global user mappings should be cleared.

· ClearDomainMappingss - Indicates that global domain mappings should be cleared.

Compare-MLSharePointFolder

· CompareFolders - Indicates whether or not to compare folders.

· CompareItems - Indicates whether or not to compare items.

· CompareVersions - Indicates whether or not to compare item versions.

· CompareMetadata - Indicates whether or not to compare object metadata.

· VerboseLog - Indicates whether or not to compare object metadata.

· HaltIfDifferent - Indicates whether or not to halt the comparison if a difference is encountered.

· FilterListsAndFolders - Indicates whether or not to filter lists and folders.

· ListAndFolderFilterExpression - The filter expression applied to lists and folders.

· FilterItemsAndVersions - Indicates whether or not to filter list items and their versions.

· ItemAndVersionFilterExpression - The filter expression applied to list items and versions.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.
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· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Compare-MLSharePointList

This is the same as Compare-MLSharePointFolder with additional parameters.

Compare-MLSharePointSite

This is the same as Compare-MLSharePointList with additional parameters:

· CompareLists - Indicates whether or not to compare lists.

· CompareSubSites - Indicates whether or not to compare sub sites.

· FilterSubSites - Indicates whether or not to filter sub sites.

· SubSiteFilterExpression - The filter expression applied to sub sites.

Get-MLSharePointDatabase

· Server - The name of the database server. (Mandatory)

· Database - The name of the SharePoint content database. (Mandatory)

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

Get-MLSharePointFolder

This is the same as Get-MLSharePointList with an additional parameter:

· FolderPath - The list-relative path to the desired folder, seperated by "/". (Mandatory)

Get-MLSharePointFolderFromDatabase

This is the same as Get-MLSharePointListFromDatabase with an additional parameter:

· FolderPath - The list-relative path to the desired folder, separated by "/". (Mandatory)
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Get-MLSharePointItembyFileName

· FileName - The filename of the SharePoint document. (Mandatory)

· FolderPath - The list-relative path to the desired folder, separated by "/".

· ListName - The name of the desired list. (Mandatory)

· SiteURL - The URL of the SharePoint site to connect to. (Mandatory)

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· AdapterType - The short name of the adapter type you want to use for the connection. Use OM for

a local SharePoint or WS for a remote SharePoint where the Metalogix Extensions Web Service is

installed.

· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointItembyID

· Id - The ID of the SharePoint item. (Mandatory)

· FolderPath - The list-relative path to the desired folder, separated by "/".

· ListName - The name of the desired list. (Mandatory)

· SiteURL - The URL of the SharePoint site to connect to. (Mandatory)

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· AdapterType - The short name of the adapter type you want to use for the connection. Use OM for

a local SharePoint or WS for a remote SharePoint where our Metalogix Extensions Web Service is

installed.

· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointItemFromDatabase

This is the same as Get-MLSharePointListFromDatabase with additional parameters:

· FolderPath - The list-relative path to the desired folder, separated by "/".

· ItemName - The filename or ID of the desired item. (Mandatory)
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Get-MLSharePointList

This is the same as Get-MLSharePointSite with an additional parameter:

· ListName - The name of the desired list. (Mandatory)

Get-MLSharePointListFromDatabase

This is the same as Get-MLSharePointSiteFromDatabase with an additional parameter:

· ListName - The name of the desired list. (Mandatory)

Get-MLSharePointServer

· ServerURL - The URL of the SharePoint server to connect to. (Mandatory)

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointSite

· SiteURL - The URL of the SharePoint site to connect to. (Mandatory)

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· AdapterType - The short name of the adapter type you want to use for the connection. Use OM

for a local SharePoint or WS for a remote SharePoint where the Metalogix Extensions Web Service

is installed.

· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointTenant

· TenantURL - The URL of the SharePoint tenant to connect to. (Mandatory)

· User - A user to connect as, in user@company.onmicrosoft.com format. (Mandatory)

· Password - The password for the user provided. (Mandatory)

· ReadOnly - Indicates that the connection made to the SharePoint tenant should be read-only.
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Get-SharePointSiteFromDatabase

· Server - The name of the database server. (Mandatory)

· Database - The name of the SharePoint content database. (Mandatory)

· SiteURL - The server-relative URL of the SharePoint site to connect to.

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· HostHeader - A host header for a specified subsite. Use this if you are connecting to a site or

subsite with a host header name.

Refresh-SharePointNode

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointFolder

· Folder - The Folder object retrieved by using the Get-MLSharePointFolder Cmdlet. (Mandatory)

·

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.
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· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointItem

· Item - The ListItem object retrieved by using the Get-MLSharePointItem Cmdlet. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointList

· List - The list object retrieved by using the Get-MLSharePointList Cmdlet. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.
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Remove-MLSharePointSite

· Site - The site object retrieved by using the Get-MLSharePointSite Cmdlet. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointSiteCollection

· SiteCollection - The Site Collection object retrieved by using the Get-MLSharePointSite Cmdlet.

(Mandatory)

· Server - The parent Server object of the Site Collection, retrieve by using the Get-

MLSharePointServer Cmdlet. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.
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Search-SharePointSite

· SearchTerm - The search term to use.

· MaxResults - The number of search results to output.

· MatchExactly - Indicates that the search term must match one of the searched fields exactly.

· Recursive - Indicates that data within all subwebs should be included in the search.

· IncludeItems - Indicates that the search results should include items.

· IncludeDocuments - Indicates that the search results should include documents.

· IncludeFolders - Indicates that the search results should include folders.

· IncludeLists - Indicates that the search results should include lists.

· IncludeSites - Indicates that the search results should include sites.

· ContentType - If specified, search results must include this value in their content type name.

· Author - If specified, search results must have been created by an author matching this value.

· Editor - If specified, search results must have been modified by an editor matching this value.

· CreatedBefore - If specified, search results must have been created before this date.

· CreatedAfter - If specified, search results must have been created after this date.

· ModifiedBefore - If specified, search results must have been modified before this date.

· ModifiedAfter - If specified, search results must have been modified after this date.

· Transformers - The collection of data transformers which the action needs to run. Note that if the passed-in

value for this parameter does not include transformers which are considered mandatory, they will be added
automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is invalid, an

exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the 'JobDatabase'
parameter will take precedence and the job will only be written to the job database.

Update-SharePointSiteCollectionSettings

· SiteCollectionAdmins - A list of login names to be granted site collection administrator privileges.

· QuotaMaximum - An independently defined maximum storage size for this site collection.
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· QuotaWarning - An independently defined size at which to send a warning email for this site

collection.

· QuotaID - A quota template ID to use for this site collection.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Metalogix.System.Commands

Set-ApplicationDataPath

· Path - The path to be used as the root folder for the application path. Note that relative path

elements relating to the product being used will still be generated within this directory, and that the

application data will be contained within those folders. (Mandatory)

· IncludeCompanyName - Indicates that the Metalogix company name should still be used as part of

the relative path from the specified directory to the application data folder.

Set-CommonDataPath

· Path - The path to be used as the root folder for the common data path. Note that relative path

elements relating to the product being used will still be generated within this directory, and that the

common data will be contained within those folders. (Mandatory)

· IncludeCompanyName - Indicates that the Metalogix company name should still be used as part of

the relative path from the specified directory to the common data folder.
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Get-MetalogixConfigurationVariable

· Name - The name of the configuration variable. (Mandatory)

· ValueType - Specify the value type of the configuration variable. This type must be IConvertible.

(Default: IConvertible).

New-Filter

· PropertyName - The name of the parameter to compare the value to on the object being filtered.

(Mandatory)

· Operand - The operand to use to compare the specified value to the given property value.

(Mandatory)

· Value - The value to compare the given property to. (Mandatory)

· CaseSensitive - Indicates if the comparison should be case-sensitive. This parameter is only

meaningful when the property to be compared to is a string.

· TypeName - The name of a type to apply the filter to. If not specified, the filter will apply to any

object.

Join-Filter

· Logic - The logic to use in the join (and or or). (Mandatory)

· FilterExpression - The filter object to join together. Can be a set of filters). (Mandatory)

Invoke-Filter

· Objects (Mandatory)

· Filter (Mandatory)

Load-MetalogixConfigurationVariableSettings

· FilePath - The full file path of the configuration variable settings file to load. (Mandatory)

· Scope - The scope to load these settings into. (Default: Environment).
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New-MetalogixSerializableObject

· TypeName - The name of the type of object to create. (Mandatory)

· AssemblyName - The name of the assembly containing the type to be created. (Mandatory)

· SerializedValue - The XML representation of a single serializable Metalogix object. (Mandatory)

· Enumerate - If set, any collections returned by the cmdlet will enumerated. Otherwise, collections

will be returned as a single object.

New-MetalogixSerializableObjectCollection

· SerializedValue - The XML representation of a Metalogix object collection. Generally this will be

obtained by requesting the PowerShell command for a job configured in the GUI. This cmdlet is not

recommended for general use. (Mandatory)

Set-MetalogixConfigurationVariable

· Scope - The scope of the configuration variable. Possible values are Environment,

EnvironmentSpecific, User, UserSpecific, Application, ApplicationSpecific,

ApplicationAndUserSpecific. (Default: ApplicationAndUserSpecific). (Mandatory)

· Name - The name of the configuration variable. (Mandatory)

· Value - The value of the configuration variable. (Mandatory)

Set-MetalogixDefaultResolverSetting

· Name - The name of the configuration variable ("ResourceTableResourceTableLink"). (Mandatory)

· Value - The value of the configuration variable. This value will indicate where to obtain configuration

key settings from. Options are local file system ("Metalogix.ResourceFileTableResolver") or agent

database (Metalogix.Core.ConfigVariables.ResourceDatabaseTableResolver). (Mandatory)

Metalogix.File.Commands

Copy-File

· IncludeFiles - Specify whether to include files. (Disabled) 

· ExistingFileAction - Overwrite, rename, or skip on existing file with same name. 
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· DefaultContentType - Specify to migrate current content using the default target content type. 

· ContentTypeID - Specify the content type id of the content type to map to. 

· ContentTypeFieldMappings - Specify field mappings from source fields to the target content type. 

· CorrectName - Enable/disable automatic replacement of invalid SharePoint characters in name. 

· CorrectNameCharacter - Specify the replacement character for invalid SharePoint characters in

name. 

· RenameFiles - Enable/disable renaming of filenames using custom column. 

· RenameColumn - Specify the column name of the column to use for renaming the files. 

· LinkCorrectionOptions - Specify the link correction options. 

· LoggingOptions - Specify the logging options. 

· PermissionsOptions - Specify the permissions options. 

· TargetHierarchyOptions - Specify the target hierarchy options. 

· StoragePointOptions - Specify the target StoragePoint options. 

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created. 

· Source - The source node for the actions. 

· Target - The target node for the actions. 

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Copy-FileAsHierarchy

· MigrateToDocSet 

· PermissionsOptions 

· TargetDocSetOptions 
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· MigrateToSubFolder 

· TargetSubFolderOptions 

· MigratePermissionsForSubFolder

· TargetDocLibOptions 

· MigrateToSubSite 

· TargetSubSiteOptions 

· MigratePermissionsForSubSite 

· TargetSubSiteTemplateOptions 

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created. 

· Source - The source node for the actions. 

· Target - The target node for the actions. 

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database. 

· UseAzureOffice365Upload - Indicates if the copy operation to Microsoft 365 should use Azure/SPO

Containers. 

· EncryptAzureMigrationJobs - If Azure/SPO Containers are being used, indicates if the job manifest

file should be encrypted.

Copy-FileAsSiteHierarchy

This is the same as Copy-FileAsHierarchy with additional parameters.

Copy-FileToSite

This is the same as Copy-File with additional parameters.
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Copy-FolderAsFolder

· ExistingFolderAction - Overwrite, rename, or skip on existing folder and file with same name. 

· IncludeSubFolders - Migrate subfolders. 

· IncludeFiles - Migrate files. 

· CorrectName - Enable/disable automatic replacement of invalid SharePoint characters in name. 

· CorrectNameCharacter - Specify the replacement character for invalid SharePoint characters in

name. 

· FilterExpression - Defines a collection of filters to be applied to the files. 

· FileSettings - Specify the file settings. 

· LinkCorrectionOptions - Specify the link correction options. 

· PermissionsOptions - Specify the permissions options. 

· TargetHierarchyOptions - Specify the target hierarchy options. 

· StoragePointOptions - Specify the target StoragePoint options. 

· DefaultContentType - Specify if default Content Type should be used. 

· ContentTypeID - Specify the ID of the default Content Type to use. 

· ContentTypeFieldMappings - Specify the Content Type field mappings. 

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created. 

· Source - The source node for the actions. 

· Target - The target node for the actions. 

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.
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Copy-FolderAsHierarchy

This is the same as Copy-FileAsHierarchy with additional parameters.

Copy-FolderAsList

This is the same as Copy-FolderAsFolder with additional parameters.

Copy-FolderAsSite

This is the same as Copy-FolderAsFolder with additional parameters.

Copy-FolderAsSiteHierarchy

This is the same as Copy-FileAsHierarchy with additional parameters.

Get-File

· Location - The location of the target item. (Mandatory)

Get-Files

· Name - Filter files by file name. 

· Extensions - Filter files by file extension. 

· MinSize - Filter files by minimum file size. 

· MaxSize - Filter files by maximum file size. 

· CreatedBefore - Filter files by before created date. 

· CreatedAfter - Filter files by after created date. 

· ModifiedBefore - Filter files by before modified date. 

· ModifiedAfter - Filter files by after modified date. 

· Location - The location of the target item. (Mandatory)
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Get-Folder

· Location - The location of the target item. (Mandatory)

Get-Folders

· Location - The location of the target item. (Mandatory)

Refresh-File

· Location - Refresh target folder. (Mandatory) 

Refresh-Folder

· Location - Refresh target folder. (Mandatory)
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Modifying Content Matrix
Configuration and Settings

14

You can configure and customize a number of Content Matrix settings, including:

· the use of encrypted SQL database connections

· proxy settings

· available actions and events

· default settings in configuration variable files

· client-side settings

· resource utilization settings

Configuring Proxy Settings

In most cases Content Matrix can automatically connect to SharePoint and authenticate license keys,

through an environment's proxy setting, However, in some cases the proxy may need to be configured

within Content Matrix. In these cases users can specify the proxy settings though the connecting

dialog. 

There are two basic places where this proxy setting can be configured. The first of these is when

activating a license key, and the second when connecting to SharePoint. The  dialogs for these options

look slightly different, and the when you are using a proxy to connect to SharePoint, you have the

additional option to Import Proxy from Internet Explorer.
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To configure proxy settings:

1. In the Proxy server dialog, check the Enable proxy box.

2. Use the information in the following table to determine the appropriate action to take.

If ... Then ...

you want to

manually enter

proxy information

A. Select Enter Manually.

B. Enter the Server name (or IP) and Port for the proxy. 

C. Specify the credentials to be used when connecting to the target server.

The Windows authenticated credentials of the current user will be

selected by default. You can specify alternate SharePoint credentials by

clicking the Different user radio button, and entering an alternate

username and password.

Internet Explorer

has been

configured to use

a proxy server via

a proxy auto-

configuration

(.PAC) file and you

want  to connect

to SharePoint

using this method

select Import Proxy from Internet Explorer.

NOTE:  This option is currently available only when connecting to

SharePoint.

Refer to the Microsoft article Auto proxy configuration settings for Internet

Explorer for more information.

3. If you accessed the dialog from the License Activation dialog, click [Set].

https://docs.microsoft.com/en-us/internet-explorer/ie11-deploy-guide/auto-proxy-configuration-settings-for-ie11
https://docs.microsoft.com/en-us/internet-explorer/ie11-deploy-guide/auto-proxy-configuration-settings-for-ie11
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Using Encrypted SQL Database Connections
When connecting to a full SQL Content Matrix Job Database, you are given the option to connect using

TLS/SSL encryption.  

NOTE:  Content Matrix can use any version of TLS that is compatible with .NET Framework 4.7.2.  The

default version of TLS used by the operating system on the machine from which you are connecting

will be used by Content Matrix.    

The encrypted connection can use either:

· a self-signed certificate or a trusted certificate from the third party authority (refer to the Microsoft

article https://docs.microsoft.c om/en-us/sql/database-engine/configure-windows/enable-

encrypted-connections-to-the-database-engine?view=sql-server-ver15 for instructions on

configuring an encrypted connection using a certificate)

OR 

· a SQL-generated certificate,  which does not require configuration.

NOTE:  If a trusted certificate is used, it is not necessary to check the Trust Server Certificate box. 

However,  if the box is not checked and the certificate is not trusted, the following message will

display:

In this case, the Trust Server Certificate box must be checked in order to continue the connection.

https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/enable-encrypted-connections-to-the-database-engine?view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/enable-encrypted-connections-to-the-database-engine?view=sql-server-ver15
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Restricting Available Actions and Suppressing
Events

Content Matrix provides you with the ability to control what actions are available to the client

application through configuring on the SharePoint server. Product behaviors can be restricted along

three dimensions: 

· Available actions

· Unrestricted users

· Suppressed events

Configuring the behavior of the Content Matrix client from target SharePoint servers requires that an

XML configuration file be added to the target SharePoint server web application directory. The XML file

must be named ServerAdapterConfig.xml and placed in the ML folder directory located within the

SharePoint hive (this is the same directory where the Metalogix SharePoint Extensions Web Service

files are). Below is an example of the typical directory location of the ML folder for SharePoint 2016

and 2019:

\\Program Files\Common Files\Microsoft Shared\Web Server Extensions\16\ISAPI\ML

ServerAdapterConfig.xml File Format

Below is an example of the simple XML format required for ServerAdapterConfig.xml.

    <ServerAdapterConfig>

      <DisabledActions>

        <Action>Metalogix.SharePoint.Actions.Migration.PasteSiteActi
on</Action>

        <Action>Metalogix.SharePoint.Actions.Migration.PasteSiteColl
ectionAction</Action>

        <Action>Metalogix.SharePoint.Actions.Migration.PasteSiteList
s</Action>

     <Action>Metalogix.SharePoint.Actions.Migration.CopyRoleAssignme
ntsAction</Action>

     <Action>Metalogix.SharePoint.Actions.Migration.CopyWorkflowAsso
ciationsAction</Action>

     <Action>Metalogix.SharePoint.Actions.Migration.PasteFolderActio
n</Action>

      </DisabledActions>

      <ExemptUsers>

        <User>METALOGIX\geordie</User>
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        <User>METALOGIX\julien</User>

      </ExemptUsers>

      <SuppressEvents>False</SuppressEvents>

    </ServerAdapterConfig>

There are three main sections within the root ServerAdapterConfig section of this XML:

· DisabledActions: This section defines the set of actions that cannot be run on the client.  See

Actions That Can Be Disabled on the Server Side for a complete list.

· ExemptUsers: This section defines the set of users by user name who are exempt from any

DisabledActions. In other words, a user in the ExemptUsers is not subject to any restrictions

imposed on Content Matrix clients by the DisableActions section.

· SuppressEvents: This section defines if any of SharePoint's event receivers are suppressed/disabled

during a migration and then restarted once the action is complete. The value for this section is set

to "True" by default, but can be manually configured if want event suppression to be disabled.

Suppression of event receivers allows Content Matrix to avoid any potential concurrency issues

when migrating (mainly with regards to workflows).

Actions That Can Be Disabled on the Server Side

Many of the SharePoint related actions available in the Content Matrix Console can be disabled on the

server side. The table below lists the complete set of client actions that can be disabled from the server

and provides the format of the action name required in the DisabledActions section of the

ServerAdapaterCongifuration.xml file.

NOTE:  When an action that is available via the client UI is disabled on the server, it will be visible in

client menus but disabled.

Action Configuration File Format

Change Global

Navigation Settings

Metalogix.SharePoint.Actions.Administration.ChangeGlobalNavigationActio

n

Change Quick Launch Metalogix.SharePoint.Actions.Administration.ChangeQuickLaunchAction

Create Folder Metalogix.SharePoint.Actions.Administration.CreateFolderAction

Create List Metalogix.SharePoint.Actions.Administration.CreateListAction

Create List From XML Metalogix.SharePoint.Actions.Administration.CreateListFromXMLAction

Create Site Metalogix.SharePoint.Actions.Administration.CreateSiteAction

Create Site Collection Metalogix.SharePoint.Actions.Administration.CreateSiteCollection

Create Site Collection

in Self-Service Mode

Metalogix.SharePoint.Actions.Administration.CreateSiteCollectionSelfServic

eMode

Delete Discussion Item Metalogix.SharePoint.Actions.Administration.DeleteDiscussionItem
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Action Configuration File Format

Delete Item Metalogix.SharePoint.Actions.Administration.DeleteFolder

Delete List Metalogix.SharePoint.Actions.Administration.DeleteItem

Delete Site Metalogix.SharePoint.Actions.Administration.DeleteList

Delete Site Collection Metalogix.SharePoint.Actions.Administration.DeleteSite

Export Doc Items Metalogix.SharePoint.Actions.Administration.DeleteSiteCollection

Publish Documents

and Pages

Metalogix.SharePoint.Actions.Administration.PublishDocumentsandPagesAc

tion

Update Site Collection

Settings

Metalogix.SharePoint.Actions.Administration.UpdateSiteCollectionSettingsA

ction

Add Role Assignments Metalogix.SharePoint.Actions.Migration.AddRoleAssignmentsAction

Copy Folder

Permissions
Metalogix.SharePoint.Actions.Migration.CopyFolderPermissions

Copy Item Alerts Metalogix.SharePoint.Actions.Migration.CopyItemAlertsAction

Copy List Alerts Metalogix.SharePoint.Actions.Migration.CopyListAlertsAction

Copy List Permissions Metalogix.SharePoint.Actions.Migration.CopyListPermissions

Copy List Role

Assignments
Metalogix.SharePoint.Actions.Migration.CopyListRoleAssignments

Paste Web Parts Metalogix.SharePoint.Actions.Migration.CopyWebPartsAction

Paste Master Page

Gallery
Metalogix.SharePoint.Actions.Migration.CopyMasterPageGalleryAction

Paste Content Types Metalogix.SharePoint.Actions.Migration.CopySiteContentTypesAction

Paste All Subsites Metalogix.SharePoint.Actions.Migration.CopySubSitesAction

Copy Web Alerts Metalogix.SharePoint.Actions.Migration.CopyWebAlertsAction

Copy Web Permissions Metalogix.SharePoint.Actions.Migration.CopyWebPermissions

Paste Workflow

Associations
Metalogix.SharePoint.Actions.Migration.CopyWorkflowAssociationsAction

Paste All List Items Metalogix.SharePoint.Actions.Migration.PasteAllListItemsAction

Paste All List Items

into Items View

Metalogix.SharePoint.Actions.Migration.PasteAllListItemsIntoItemsViewActi

on

Paste Audiences Metalogix.SharePoint.Actions.Migration.PasteAudiencesAction

Paste Default Web

Part Page
Metalogix.SharePoint.Actions.Migration.PasteDefaultWebPartPageAction
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Action Configuration File Format

Paste Duplicate List Metalogix.SharePoint.Actions.Migration.PasteDuplicateListAction

Paste Duplicate Site Metalogix.SharePoint.Actions.Migration.PasteDuplicateSiteAction

Paste Folder Metalogix.SharePoint.Actions.Migration.PasteFolderAction

Paste List Metalogix.SharePoint.Actions.Migration.PasteListAction

Paste List as Folder Metalogix.SharePoint.Actions.Migration.PasteListAsFolderAction

Paste List Email

Notifications
Metalogix.SharePoint.Actions.Migration.PasteListEmailNotificationAction

Paste List Item Metalogix.SharePoint.Actions.Migration.PasteListItemAction

Paste List Item into

Items View
Metalogix.SharePoint.Actions.Migration.PasteListItemIntoItemsViewAction

Paste My Sites Metalogix.SharePoint.Actions.Migration.PasteMySitesAction

Paste Navigation Metalogix.SharePoint.Actions.Migration.PasteNavigationAction

Paste Roles Metalogix.SharePoint.Actions.Migration.PasteRolesAction

Paste Site Metalogix.SharePoint.Actions.Migration.PasteSiteAction

Paste Site Collection Metalogix.SharePoint.Actions.Migration.PasteSiteCollectionAction

Paste Site Content Metalogix.SharePoint.Actions.Migration.PasteSiteContentAction

Paste Site Lists Metalogix.SharePoint.Actions.Migration.PasteSiteLists

Remove Role

Assignments
Metalogix.SharePoint.Actions.Migration.RemoveRoleAssignmentAction

Event Suppression Metalogix.SharePoint.Actions.Migration.SuppressEvents

Note that many of the above listed actions are used by other actions. When a given action is enabled,

but one or more of its sub-action is disabled, the sub-actions will not run. When a user attempts to run

an action for which sub-actions are disabled, they will be notified with a dialog similar to the following:
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Configuration Variable Files

Content Matrix uses a set of configuration variable files behind the scenes to help set and manage

settings for all of the Content Matrix Editions. This section explains what the configuration variable

files are, their general behavior, and where to find them.

Configuration variables are contained in the following three files:

· EnvironmentSettings.xml

· UserSettings.xml

· ApplicationSettings.xml

Some settings can be configured for all Product Editions, while other settings are limited to individual

Product Editions.

Any settings that are configured in multiple files will be scoped to the lowest level (either in the

"UserSettings.xml" file or the "ApplicationSettings.xml" file), including values that are pulled from the

old EnvironmentSettings.xml file.

IMPORTANT:  Make sure the Content Matrix Console is closed when making updates to configuration

variable files.

EnvironmentSettings.xml File

This file allows users to configure general settings for all Product Editions. This means that these

settings only need to be set in a single file, either for all users of the machine (if users are required to be

local administrators) or for each individual user of the machine (if users are not required to be local

administrators) and can be found in one of the following locations:

· If you are required to be a local administrator on the machine where Content Matrix is installed: C:

\ProgramData\Metalogix

OR

· If you are not required to be a local administrator on the machine where Content Matrix is installed: 

C:\Users\<username>\AppData\Roaming\Metalogix\Common

UserSettings.xml File

This file allows users to configure general settings for all Product Editions for a specific user account

(the logged in account). This means that these settings will be configured for all Product Editions, but

only for the current user account. If another user would like to configure these same settings to work

for them, they must be configured manually under the appropriate user account.  It can be found in the

following location:

C:\Users\<USER>\AppData\Roaming\Metalogix
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ApplicationSettings.xml File

This file allows users to configure settings that are limited to the specific Product Edition of Content

Matrix Console, for a specific user account (the logged in account). This means that each Product

Edition, for every user account, must be configuredindividually. While the "ApplicationSettings.xml" file

for each Product Edition can contain some of the same settings, there are some settings that are

Edition specific (for example, some settings may only work for SharePoint Edition, so they will only be

available in SharePoint Edition). Any settings that are replicated through various version of the file will

only be applied to the specific Edition.

For example, the "AllowCheckResults" setting is available in every "ApplicationSettings.xml" file, but it

must be set on an individual Product Edition basis. Setting it for SharePoint Edition will not configure it

for Public Folder Edition.  It can be found in the following location: 

C:\Users\<USER>\AppData\Roaming\Metalogix\Content Matrix Console - <Product> Edition.

Client Side Configuration
For an individual Content Matrix Console instance, you can Configure Settings for Migrations Using

the Import Pipeline.

Configuring Settings for Migrations Using the Import
Pipeline

Content Matrix has various XML properties that can be modified to fine-tune or help troubleshoot your

Import Pipeline migrations.  These properties can be found in the EnvironmentSettings.xml file.

NOTE:  You can also contact Quest Support for assistance in identifying and resolving issues with

migrations using the Import Pipeline.  For a list of supported migration actions, see Objects and

Actions Supported for Using the Import Pipeline.  

Batch Size Settings

The following XML properties can optionally be modified. However, it is generally recommended to not

modify these values unless you are encountering issues when migrating using the Import Pipeline.

UploadManagerBatchSizeItemThreshold

This key controls the maximum batch size in item count, including all folders and documents, to be used

if Content Matrix will be submitting batches according to number of items. The default value is 200 and

the value must be a positive integer.

<XmlableEntry>
<Key>UploadManagerBatchSizeItemThreshold</Key>
<Value>200</Value>
</XmlableEntry>

UploadManagerBatchSizeMBSizeThreshold

https://support.quest.com/
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This key controls the maximum batch size to be used if Content Matrix will be submitting batches

according to size. The default value is 1000 megabytes and the value must be a positive integer. The

value should be set carefully, taking into consideration factors such as total upload bandwidth, speed

of data retrieval from the source system, and so on.

<XmlableEntry>
<Key>UploadManagerBatchSizeMBSizeThreshold</Key>
<Value>1000</Value>
</XmlableEntry>

Batch Resubmission Settings

MaxAzureBatchRetryCount

This key controls the maximum number of times Content Matrix will resubmit the batch until it is

successfully migrated.  (The default value is 5.)

<XmlableEntry>
    <Key>MaxAzureBatchRetryCount</Key>
    <Value>5</Value>
</XmlableEntry>

ErrorMessagesForRetryAzureBatch

This key specifies error conditions for which you want Content Matrix to resubmit a batch, when it

normally would not.  

NOTE:  Separate multiple error messages with a pipe character (|), as shown in the example below.

 <XmlableEntry>
    <Key>ErrorMessagesForRetryAzureBatch</Key>
    <Value>Item does not exist|Object Reference Not Set</Value>
  </XmlableEntry>

Performance Settings

BufferSizeForPipelineMigrationInMb

This key controls the buffer size while uploading files to Azure Storage Account Containers using the

Import Pipeline. The default value is 64, which means, for example a 128 MB file will be uploaded in

two parts, 64 MBs at a time.  The lower buffer size, the more quickly the computer processor handles

the information. Keep in mind that the higher the value, the more system resources will be consumed.

<XmlableEntry>
    <Key>BufferSizeForPipelineMigrationInMb</Key>
    <Value>64</Value>
</XmlableEntry>

MaxParallelUploadFilesInPipeline

This key controls the number of files uploaded in parallel to Azure Storage Account Containers when

using the Import Pipeline.  The default value is 2, which means a maximum of two files can be uploaded

in parallel.  Keep in mind that the higher the value, the more system resources will be consumed.

<XmlableEntry>
    <Key>MaxParallelUploadFilesInPipeline</Key>
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    <Value>2</Value>
</XmlableEntry>

UploadManagerMaxRetryCountThresholdForJobResubmission

WARNING: This value should not be changed unless absolutely necessary. 

This key controls the amount of time to wait for a response from the reporting queue before re-

requesting a migration job. This value is specified in multiples of 15 seconds, meaning that the default

value of 960 corresponds to 4 hours and the minimum value of 120 corresponds to 30 minutes. This

value must be a positive integer greater than or equal to 120.

<XmlableEntry>
    <Key>UploadManagerMaxRetryCountThresholdForJobResubmission</Key>
    <Value>960</Value>
</XmlableEntry>

Temporary Storage Location

UploadManagerLocalTemporaryStorageLocation

This key indicates the directory in which the temporary binary files and manifest XML files for each

batch are saved. If no filepath is specified, the default file path is used.

<XmlableEntry>
    <Key>UploadManagerLocalTemporaryStorageLocation</Key>
    <Value>C:\ProgramData\Metalogix\Temp folder sample</Value>
</XmlableEntry>

Changing Resource Utilization Settings
How many threads can be used simultaneously per job in Content Matrix is controlled by the Edit

Resource Utilization Settings option, which is accessible from the Settings ribbon at the top of the

Console UI.

If the option is clicked, a dialog containing a slider will appear that will allow control of the number of

threads available within a single action. If the slider is moved all the way to the left, this will turn off

multithreading and only allow a single thread to be used during the action. (For more information on

threading, refer to the Microsoft article About Processes and Threads.)

NOTE:  Turning off multithreading in this way can be a valuable way of troubleshooting whether

multithreading is causing issues.

If the slider is left in the middle, it will allow twice the number of processors in threads to be created

per action. For example, if the machine running Content Matrix has a two core CPU, four threads will

be able to be used if the slider is in the below state:

https://docs.microsoft.com/en-us/windows/win32/procthread/about-processes-and-threads
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Moving the slider farther to the right will allow more threads to be used, but can potentially overwhelm

system resources.  This could lead to potential errors if the system resources cannot handle the data

being migrated.  There is a chance that if the speed is too high, you would see a slowdown in the

overall migration, because the migration is trying to run actions faster than the resources properly

allow.

While this value can be set through the Content Matrix Console, you can also set it through the back

end, if the UI setting does not seem to be working for you. Please contact Quest Support for more

information on this back end setting.

https://support.quest.com
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Frequently Asked Questions

15

This section answers some of the most frequently asked questions about using Content Matrix.

Activating the License Key Silently

Question

I would like to activate my license outside of the Content Matrix Console.  Is that possible?

Answer

You can activate your Content Matrix license using PowerShell.  Follow the steps below.

NOTE:  This method can only be used for online activations.

1. Open the Content Matrix PowerShell Console.

2. Run the following cmdlet, which includes specifying the Content Matrix Console Edition for which

you want to activate the license.

if (Get-Command Set-MetalogixJobPrerequisites -ErrorAction
SilentlyContinue){ Set-MetalogixJobPrerequisites -Value "Content Matrix
Console - <Edition_name>" }

NOTE:  Valid values for <Edition Name> are SharePoint Edition, FileShare Edition and Public

Folder Edition.  If you license covers more than one Edition, it is only necessary to activate one. 

The license activation will automatically be applied to any other Edition for which you are

licensed.

3. Run the Set-MetalogixLicense cmdlet.  Note that additional parameters are required if a proxy

server is used.

Without proxy server:

Set-MetalogixLicense -Key "<license_key>"

With proxy server:

Set-MetalogixLicense -Key "<license_key>" -ServerUrl
"<proxy_server_IP_addres>" -Port "<proxy_port_number>" -UserName
"<user_account>" -Password "<password>"

NOTE:  When entering the license key, include hyphens.
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Created Dates Not Retained

Question
We reviewed the upload process and observed that created date was not retained but all other

attributes (modified date, modified by and created by) were all correctly set. What could cause this?

Answer
In some cases customer try to set a created date that is more recent than the modified date. This is not

allowed by SharePoint. As a result, the created date will be set to the current date.

General Limitation Questions

Question
1. Is there a limit to the number of items you can be listed under a File Share Connection?

2. Is there a limit to the number of rows and columns that you can have in the File Share Edition?

3. Is there an expected amount of memory usage?

Answer
1. This partly depends on the machine that is running the Content Matrix Console. Depending on the

machine it is recommended to only go as high as 5000 items under a File Share connection.

2. This is similar to the number of items. Since it is recommended to only go as high as 5000 items

under a File Share connection, and each item is the same as one row in the Items View tab, we

recommend to only go up to 5000 rows under a specific File Share connection. While there is no

limit to this for columns, since these are only related to rows in that it is information for items, it

would still be a good general rule to not exceed 5000 columns, but going over this should not be an

issue.

3. Content Matrix Console uses an in memory Database (DB) for it's project files, so the amount of

memory used can get quite large depending on the number or rows and columns that are included

under the File Share connection. To help reduce the in-memory footprint any long strings are stored

in the DB, and not in the memory. Since each user's migration scenario is different, we can't

accurately give an expected amount of memory usage.

License Key Troubleshooting

Question

I have been unable to get Content Matrix to recognize my license key. When I copy and paste it into

the box, I get a "the specified license key is invalid" error.
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Answer

Here are some things to check:

· Make sure that the license covers the product edition.  (For example, if you are licensed for

SharePoint Edition and try to activate the license for Public Folder Edition, the invalid error will

display.) 

· Confirm that the license you are installing is for the correct application versions of Content Matrix.

Contact Quest to verify that it is. (For example, license keys beginning with 823, 824, and 827 are not

compatible with File Share Edition since its reintroduction in version 9.9.)

· When performing an offline key activation, make sure to enter the long key in its entirety, including

the "=" symbol at the end of it.

· Verify that you have write privileges to the registry. The installer will fail if the registry is locked. In

some cases there may be a group plicy that is preventing the user from adding the key in the registry,

despite the user having the correct permissions.

· Some versions of Windows will automatically block write access to the registry under the user

account, even if that account has write access to the registry. In this case you can go to the

application installation folder, right click on the application .exe file, and choose 'Run as

Administrator'. Then re-enter the license key.

Errors Connecting to SharePoint 2019 or
SharePoint Server Subscription Edition in a
FIPS-Enabled Environment

Question

Why am I getting an error when I try to connect to SharePoint 2019 or SharePoint Server Subscription

Edition in a FIPS-enabled environment?

Answer

Content Matrix uses some assemblies for FIPS compliance that are not supported for certain

SharePoint 2019 and SharePoint Server Subscription Edition connections.  

For a remote object model (MEWS) connection (displays for the top node) for SharePoint 2019:

Client found response content type of 'text/html; charset=utf-8', but expected 'text/xml'. The request

failed with the error message: -- <!DOCTYPE html> <html>

For a local object model (OM) connection (displays at the item level for SharePoint 2019 and

SharePoint Server Subscription Edition):

https://www.quest.com/company/contact-us.aspx
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The type initializer for 'Microsoft.SharePoint.ApplicationRuntime.SPRequestModule' threw an exception

In addition, errors will display in Browser View and Items View.  

For SharePoint Server Subscription Edition, you can connect using a remote object model (MEWS)

connection.  

Changing a Job Configuration for Multiple Files

Question

Is it possible to change the configuration for multiple job files at one time in the Job List section of

Content Matrix?

Answer

Yes, this is possible. Most users will only need to change the configuration of a single job in the Job List

section, but it is possible to change the configuration for multiple jobs at one time.

In order to modify the configuration for multiple job files at one, select all of the jobs in the Job List

section. Once all of the desired jobs are selected there are two methods that can be used to access the

configuration dialog. The first is to click the Change Configuration button at the top of the Job List,

and the second method is to open the context (right-click) menu, and select the Change configuration

for selected jobs option.

The behavior for changing the configuration of multiple files at once changes slightly depending on the

version of Content Matrix Console that is being used.

Behavior in Versions 6.1.00 and Later

When changing the configuration for multiple files that use the same type of action at once, only

settings that are changed during the re-configuration will be pushed into all of the selected jobs. This

means that even if all of the jobs contain different settings, they will all still contain these different

settings after the configurations have been modified. Only the settings that were re-configured will be

changed (to whatever setting they were changed to).

Let's look at the example of three "Paste Site" jobs that are previously configured, and each has a

different Rename action applied to it as well as a few various other differences in selected options.

When the Change Configuration is applied to all three at once, only the settings that were

reconfigured will be affected. So if the web part options were changed, then those options will be

applied to all three jobs, but each will still retain their original Rename setting, and any other settings

that were configured even if there are differences.

Behavior in Versions 6.0.0201 and Earlier

When changing the configuration for multiple files that use the same type of action at once, all of the

selected files will have the options for the first job in the Job List section pushed into them, regardless
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of any other setting the previously used. Basically, all of the jobs after the first select job in the Job List

will be modified to use all of the settings from the Change Configuration dialog.

Let's look at the example of three "Paste Site" jobs that are previously configured, and each has a

different Rename action applied to it as well as a few various other differences in selected options.

When the Change Configuration is applied to all three at once, all of the configuration options that are

set for the first of the selected jobs in the Job List will be pushed to the two remaining jobs. These two

remaining jobs would then use all of the exact same configuration options as the first job, including the

values for the rename options. Any of the previous settings for the two remaining jobs would be lost

(because they are replaced with the first jobs configuration options).

Multiple Clients

Question
Does Content Matrix Console - File Share Edition support running multiple clients at the same time?

Answer
Content Matrix Console - File Share Edition does not currently support running multiple migration

actions at one time through a single instance of the client. However, it is possible to open multiple

copies of the client and have each one run a separate migration action. If multiple instances of the

client are opened at the same time to run migrations, users will need to make sure that the source

documents/folders are not being copied from the same location, and that the selected target is not the

same SharePoint list/site. If the source and target location overlap for multiple concurrent migrations

there is a possibility that the SharePoint APIs that are called by File Share Edition will conflict and they

will try to overwrite one another. As a result the migrated content may not migrate correctly, and will

have to be re-migrated at a later date.

Source Files

Question
I was wondering what happens to files on the share drive after we migrate them to SharePoint? Are

they marked or flagged on the share drive as having been migrated or are they deleted?

Answer
The files on the file system are left as is. Content Matrix Console - File Share Edition only performs read

operations on source files.

Your Content Matrix Console - File Share Edition project is the best way to track what has been

migrated. We do provide a facility to remove the files from the source location post-migration--if that

is what you are looking for. Obviously, this is something to use carefully and we would be happy to

discuss further whether this might be useful in your case. Please contact Quest Support for more

information.

https://support.quest.com
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Using Proxies, Load Balancing or Alternate
Access Mappings

Question

How does Content Matrix deal with environments that use proxies, load balancing and/or alternate

access mappings (AAM)?

Answer

Content Matrix Console should not run into any issues with these three things. Content Matrix uses the

Metalogix Extensions Web Service (MEWS), which deploys over a whole farm and functions

identically to a regular SharePoint web service. SharePoint web service's get the benefits of IIS

redirection, proxy pushing, and anything else that SharePoint can utilize, such as Alternate Access

Mappings (AAM). Since the Metalogix Extensions Web Service acts the same as a SharePoint web

service it also gets all of these benefits.

In the case for load balanced environments the Metalogix Extensions Web Service would need to be

deployed through the target side SharePoint farm. When the Web Service is installed it automatically

gets deployed to all the SharePoint instances within that farm, as a SharePoint solution. Once the Web

Service is installed on the target server, then load balancing should no longer be an issue.

There are, however, some cases where proxy settings may not work correctly by default. In these cases

it is possible to set some specific proxy settings for the specified connection. Please see the Configuring

Proxy Settings page for more details.

SharePoint Site Collection Creation Issue

Question

I have been trying to create a new site collection through Content Matrix but I have been encountering

issues. Why is this happening? and what can I do about it?

Answer

Starting with SharePoint 2013, most web applications use claims authentication, but the Central

Administration web application that manages the server level settings uses Classic authentication. When

Content Matrix Console connects to a SharePoint server it has to authenticate through a web

application. When connected to a SharePoint 2013 or later web application that uses Claims

authentication, SharePoint itself can have trouble recognizing that the accessing User account has

permissions in the web application areas that are managed by Classic authentication. This is also true if
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connected to a web application that uses Classic authentication, if trying to access an area managed by

Claims authentication.

The permissions to create site collections is managed by Classic authentication, so if connected

through a Claims authentication web application users will receive a "401 Unauthorized" error message

when trying to create a new site collection. This happens even if the user account has all of the

appropriate permissions. If connecting through a Classic authentication web application, users will

receive permission errors when trying to set any settings on a site collection that uses a Claims

authentication web application, after the site collection is created.

From internal testing, we have determined that SharePoint connections that use the
Local Object Model will not run into this issue. This is because the Local OM connection
type does not run authentication through IIS, which appears to be a trigger point for
the authentication issues.

From testing we have also determined that you are still able to create SharePoint site

collections when using the Remote OM connection type, but in order to do this Content

Matrix Console must elevate your permissions for the creation step. Before elevating

any credentials, Content Matrix Console will run a preliminary check to ensure the

migrating user has enough permissions initially to be able to use the elevated site

collection creation. In order for these elevated permissions to be used, the migrating

user account must explicitly (by name) have "Full Control" permissions on the Web

Application that the site collection is being created on.

In the Remote OM connection case users can also create a site collection within any

web application if they are a member of the Farm Administrator group in SharePoint

and they are connected to Central Administration as a farm connection.

Possible Errors when Creating Site Collection in SharePoint 

Below is a list of errors (and their explanations) that you might encounter when trying to create site

collections in SharePoint through Content Matrix Console.

· Error Message 1 - Unable to obtain Web Application '<web application name>'.

Explanation/Resolution - Content Matrix is unable to find the web application. This should not occur

unless a serious issue within SharePoint has occurred from the time the site collection configuration

dialog was displayed, and the call to the Metalogix Extensions Web Service (for remote OM

connections) was made to perform the site collection creation. Check your SharePoint environment,

and resolve any issues. Then try again.

· Error Message2 - Migrating user '<migrating user>' requires explicit Full Control on the web

application where the site collection is intented to be created. If the migrating user is a member of

the Farm Administrators group then connect to the Central Administration site and try again.

Explanation/Resolution - The migrating user has read permissions on the web application (using a

farm or web connection type) that they're connected to, but does not have full control on the web

application that they are trying to create the site collection in. To resolve this, the migrating user
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account must be added explicitly (by name) with Full Control to the respective Web Application that

they are trying to create the site collection in. They can also create a site collection within any web

application if they are a member of the Farm Administrator group in SharePoint, and they are

connected to Central Administration as a farm connection.

Job List Database fails to Load After Upgrade

Question

I recently upgraded to Content Matrix Console version v.6.2.x.x and my Job List database is failing to

load. What might be causing this issue? and how can I fix it?

Answer

This issue was likely caused by a recent upgrade to Content Matrix Console's security features. A

security upgrade has been made in Content Matrix Console version 6.2.0.0 and later. This change has

resulted in two potential issues that users can encounter. These issues and their resolutions are:

· Issue 1: The Job List database failing to load.

Resolution: When the Content Matrix Console client opens, an error message will prompt the user to

open the Job List file again. Go down to the Job List section and click File > Open Job List. This will

open a Browser window. Navigate to the location that contains the LST file for the Job List that was

previously listed in the Job List section. Then select the LST file and click Open. The Job List will now

be loaded and users can continue as normal.

Due to the security upgrades in version 6.2.0.0 and later, the security settings for the Job List need to

be upgraded. Content Matrix Console cannot do this while the job is actively selected, but can apply

the update to the existing Job List the next time it is loaded back to the Job List section of the client

application.

· Issue 2: Any connections that have had the Save my credentials check box selected will no longer

have their passwords saved.

Resolution: For any connections that had their credentials previously saved by using the Save my

credentials option, you will need to connect or reconnect to that environment and enter the

password in again, then complete the connection. The security upgrade has caused the encryption

file for any saved passwords within Content Matrix Console to be upgraded, and to apply this

upgrade to this file, any saved passwords must be re-entered.
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Migrating Empty Folders

Question
Is it possible to migrate any empty folder within my File Share?

Answer
Yes, it is possible to migrate any empty folders into SharePoint. By default any empty folders that exist

within the File Share folder structure will be migrated into the target SharePoint environment.

If the configuration options for the migration are set to determine the folder name (that each file

should be migrated into) based on the data in a custom column, then any empty folders will still be

migrated but they will ignore this setting and instead use the original empty folder name.

Retrying Failed Document Copies to O365 CSOM
Connections

Question

When I try to migrate some of my content into Microsoft 365 using a SharePoint CSOM or Microsoft

365 Tenant connection type, and this content contains a large Document Library, I see that some of my

documents fail to migrate. The logs for the failure indicate that a "HTTP 500 - Internal Server Error"

was thrown. What is the cause of this? And how can I fix it?

Answer

There is a potential issue when migrating specifically to SharePoint Online where users can encounter

an "HTTP 500" error. This is caused by a combination of the CSOM/Tenant connection adapter and

SharePoint's document upload methods. To help resolve this issue there is a document retry feature

that can be configured. This retry feature will attempt to upload the document(s) into the SharePoint

Online  target, and depending on the configured setting, will attempt to retry the upload process if it

fails or times-out on the initial try.

The below steps will explain how to enable and configure this retry setting.

NOTE: This retry method is only meant for migrating to SharePoint Online  targets. If you are

migrating to an on premises target, then this retry feature will not benefit you since it makes use of

Microsoft 365 specific methods.

1. Make sure that the Content Matrix client application is closed.

2. In the file system that the Content Matrix Console client application is installed on, navigate to the

the appropriate file location:
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· If you are required to be a local administrator on the machine where Content Matrix is installed: 

C:\ProgramData\Metalogix

OR

· If you are not required to be a local administrator on the machine where Content Matrix is

installed:  C:\Users\<username>\AppData\Roaming\Metalogix\Common

3. In this location there should be an EnvironmentSettings.xml file. Open this file in an editor

program. For example, Notepad, etc.

4. There are two variables that will need to be modified in order for the retry method to work. They

are:

· CSOMDocumentRetriesNumber - This value determines the number of times that Content

Matrix will make another attempt to upload/migrate any document(s) that has failed the initial

document upload try, when migrating to a SharePoint Online CSOM target.

· CSOMDocumentRetriesDelay - This value determines the amount of time, in seconds (s), that

Content Matrix will wait before starting a document upload retry, and is based on the above

("CSOMDocumentRetriesNumber") variable.

NOTE: The default values for these two variables will be set as "0". Users can set these values as

desired, based on what works best for their environment.

5. After the desired values have been entered in the two variables, save and close the file.

6. Restart the Content Matrix client application. The changes should now be in Content Matrix

Console, and used when running any migration to a SharePoint Online target environment.

After these values have been set and the client application has been restarted, any documents that fail

on the initial migration attempt we be retried.

IMPORTANT:  If these steps do not resolve the issue and you are using the Import Pipeline for the

migration, the error may be pipeline-related.  See "Error, the batch will be resubmitted" Message

Displays When Using the Import Pipeline for details.

Import Pipeline Batches Getting Stuck

Question

I am migrating some content using the Import Pipeline.  After some time the batches seem to simply
stop. Why am I facing this issue?
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Answer

Migration duration and overall performance using the the Import Pipeline may vary due to factors
outside the control of Content Matrix. Migration processing resides within Microsoft's domain and is
subject to Microsoft's internal processes, such as maintenance and upgrades.

You may experience a delay of several hours before batch completion if the machines that Microsoft
uses undergo maintenance/upgrades or if there are Microsoft 365 service issues/outages (as can be
seen in the Microsoft 365 Admin Center under Service Health).

Error: 'The object is associated with property
AssociatedMemberGroup.'

Question

When attempting to copy an object to a SharePoint Online site or OneDrive, why do I receive the

following error?

Object reference not set to an instance of an object on server. The object is associated with property

AssociatedMemberGroup.

Answer

This error may occur when one or more of the default SharePoint groups (Owners, Members, and/or

Visitors) are not present on the target. 

NOTE: For OneDrives, none of these groups are present by default.
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Create the missing default group(s) on the target.  Refer to the applicable Content Matrix Knowledge

Base article for more information.

Migration Error: 'ERROR, the batch will be
resubmitted to the import pipeline'

Question

What does it mean when the message ERROR, the batch will be resubmitted to the import pipeline

displays in the Information section of the Log Item Details dialog when a migration is performed using

the Import Pipeline?

Answer

You may see this message (which will begin with either ERROR or FATAL ERROR) during a migration

when a batch fails to migrate in its entirety.  To address this issue, increase the value of the

environmentsettings.xml key MaxAzureBatchRetryCount.  This key controls the maximum number of

times Content Matrix will resubmit the batch until it is successfully migrated.  (The default value is 5.)

The batch retry mechanism will also be triggered for the following errors:

· Please try again. CallStack -- at Microsoft.SharePoint messages 

· Access denied

· Save Conflict The system cannot find the path specified. (Exception from HRESULT: 0x80070003) 

· Updates to system roles is not allowed. 

https://support.quest.com/content-matrix/kb/4371070/the-object-is-associated-with-property-associatedmembergroup
https://support.quest.com/content-matrix/kb/4371070/the-object-is-associated-with-property-associatedmembergroup
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· List does not exist

For any error not listed above (such as Item Does Not Exist, which is different than List does not Exist), a

batch will be resubmitted only if the error message is added to the environmentalsettings.xml key

ErrorMessagesForRetryAzureBatch.

IMPORTANT:  If adjusting this setting does not resolve the issue, the error may be with the CSOM

connection.  See Retrying Failed Document Copies to SharePoint Online CSOM Connections for

details.

Support for GCC High Tenants

Question

Does Content Matrix support SharePoint Online GCC High connections?

Answer

Refer to the following table for specific target connections that Content Matrix supports for GCC High

tenants.

IMPORTANT:  In order to use ADFS authentication with a GCC High tenant you must first run a utility

provided by Quest Support and enable the setting EnableUserProvidedAuthentication. Refer to the

Quest Support Knowledge Base article Enabling User Provided Authentication in Content Matrix for

details.

Connections

Target

Type

OAut

h

OAuth with

MFA

ADFS ADFS 

(Microsoft 365

User Provided

Authentication)

Web

Browser

Authenticati

on

Microsoft 365

Web Browser

Authentication

Tenant -- -- --

Site -- --

https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
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Quest creates software solutions that make the benefits of new technology real in an increasingly

complex IT landscape. From database and systems management, to Active Directory and Microsoft 365

management, and cyber security resilience, Quest helps customers solve their next IT challenge now.

Around the globe, more than 130,000 companies and 95% of the Fortune 500 count on Quest to deliver

proactive management and monitoring for the next enterprise initiative, find the next solution for

complex Microsoft challenges and stay ahead of the next threat. Quest Software. Where next meets

now. For more information, visit www.quest.com. 

Contacting Quest
For sales or other inquiries, visit www.quest.com/contact.

Technical Support Resources
Technical support is available to Quest customers with a valid maintenance contract and customers

who have trial versions. You can access the Quest Support Portal at https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and independently,

24 hours a day, 365 days a year. The Support Portal enables you to:

· Submit and manage a Service Request

· View Knowledge Base articles

· Sign up for product notifications

· Download software and technical documentation

· View how-to-videos

· Engage in community discussions

· Chat with support engineers online

· View services to assist you with your product

http://www.quest.com
http://www.quest.com/contact
https://support.quest.com
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